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CM01/02 Updater (a DB/Pre-Game Editor) latest version post #239

Over the past two weeks I have been hard at work porting over my Eastside Hockey
Manager 2007 editing tool (aka EHM 2007 Updater) to CM01/02. Many thanks to Hugo9
who posted the CM database structure here, enabling me to start porting over my tool.
If you want to see the sort of things my EHM 2007 Updater can do (so you can see
what sort of things I hope to port over to the CM01/02 Updater) then there's a
changelist and some screenshots here (the screenshots are slightly out of date now):
http://www.ehmtheblueline.com/forums...157635#p157635

I'm hoping to release the first version of the Updater soon, but thought I'd post a couple
of screenshots and a brief update seeing as progress is going really well. Here's what I've
done thus far:

- Loading and saving the database
- Exporting various data. You can export either to CSV or XML (you can choose from the
Settings menu). CSV has smaller file sizes, but XML creates tidier spreadsheets (basically
the same sort of formatting as XLS/XLSX spreadsheets).
- Adjusting all years in the DB (I just need to extend it to the dates stored in the cfg
files).

Things I'll be doing next:

- Ability to make players and/or non-players free agents.
- Ability to delete various parts of the database (e.g. delete all staff or staff career
history) - including the ability to generate a blank database (but it won't delete nations,
cities, teams, etc as these are essential for the game to work).
- Ability to edit existing data via CSV/XML spreadsheets (e.g. create a list of attributes
you want to edit from existing players in a spreadsheet and the Updater will apply them
to the DB).
- Ability to import new data from CSV/XML spreadsheets (e.g. create new staff, import
staff career history, etc).

Here are a couple of early screenshots:

#1

Reserve Team Player
archibalduk 

Forum

https://champman0102.co.uk/forum.php
https://champman0102.co.uk/faq.php
https://champman0102.co.uk/forum.php
https://champman0102.co.uk/faq.php
https://champman0102.co.uk/calendar.php
javascript://
https://champman0102.co.uk/search.php
https://champman0102.co.uk/index.php
https://champman0102.co.uk/forum.php
https://champman0102.co.uk/forumdisplay.php?f=156
https://champman0102.co.uk/forumdisplay.php?f=12
javascript://
javascript://
https://champman0102.co.uk/showthread.php?t=5288&page=2
https://champman0102.co.uk/showthread.php?t=5288&page=3
https://champman0102.co.uk/showthread.php?t=5288&page=4
https://champman0102.co.uk/showthread.php?t=5288&page=5
https://champman0102.co.uk/showthread.php?t=5288&page=11
https://champman0102.co.uk/showthread.php?t=5288&page=2
https://champman0102.co.uk/showthread.php?t=5288&page=13
javascript://
https://champman0102.co.uk/showthread.php?t=5288&p=177686#post177686
https://champman0102.co.uk/member.php?u=49477
http://www.champman0102.co.uk/showthread.php?t=5187&p=173351#post173351
http://www.ehmtheblueline.com/forums/viewtopic.php?p=157635#p157635
https://www.facebook.com/champman0102
https://www.facebook.com/champman0102
https://www.facebook.com/champman0102


The tool is compatible with Windows XP onwards.

Finally, just to say a MASSIVE THANK YOU to the likes of Taipani, John Locke and the
guys that run the site and the DB updates. Thanks to you, I have re-discovered the joys
of CM01/02 so many years after I last played it. 

Last edited by archibalduk; 05-07-14 at 09:07 PM.
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This will be fantastic  Great work 
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- Ability to import new data from CSV/XML spreadsheets (e.g. create new staff, import staff career history, etc).
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Good stuff Archie, i'm sure this will be a very helpful tool for our update team  Oh, and welcome to the site 
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Wow, has there ever been a more exciting time on the forum, Tapani, John Locke & Archibalduk all working their magic.

From a personal point of view, if this comes off and you can extract/inject to a CSV or XML document, the possibility of a fully updated
0001 is nearer to a reality than ever before.

Great work Archie.
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Top, top stuff Archie. You're an asset to the forum already with this magic! I don't think words can explain how key this sort of thing
can be for the game and the future.
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It looks promising, but I just truly hope that to use this program I won't need to have admin rights...
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One way to possibly avoid that is to install CM somewhere that is NOT on C: drive.

Having used the EHM version of this tool extensively I can say with confidence that this will be great.

#7

Backup Player
Rapinoe 

 Originally Posted by Edgars 

It looks promising, but I just truly hope that to use this program I won't need to have admin rights...
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Archie - a question/suggestion: are you planning to include that 'count' screen that shows the number of players in each league with
minimum, maximum and average CAs? I think that could also be quite useful here too.
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I am running the game and original editor without admin rights and without any issues on Windows 7, so that won't be a problem!
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One way to possibly avoid that is to install CM somewhere that is NOT on C: drive.

Having used the EHM version of this tool extensively I can say with confidence that this will be great.
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Posts: 3,608

archibald, since this tool can be very very helpful for the update team, can you also add any features requested by the team?

if so, you and the team could cooperate to make this tool as best we can

Director
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If your database is located in C:/Program Files(x86)/.../ then yes you'd need to use Run as Admin (otherwise you end up with ghost
copies of your DB in your Roaming folder).

BUT, you can easily avoid this by coping your DB (i.e. all of your .dat files plus player_setup.cfg) to another folder temporarily. E.g. if
you move it to a folder on your Desktop or My Documents then you don't need to use Run as Admin. It's only when it's in Program Files
where you have to worry about admin rights.

Will do! I'll get the Free Agent Utility and Delete DB functions done and then I'll move on to that for you.

Yes, I would be more than happy to do so. The aim of my tool is to make DB editing easier for the guys who maintain the excellent
roster updates. So please do post suggestions and I'll see what I can do. I won't make any promises, but it would be really useful to
know what sorts of things would help the roster update team because then I can prioritise those aspects.

I must however stress that I do have a heavy workload and so progress on this tool will be very stop-start. Just to give you an idea of
the other things I have on my plate: 1) I'm continuing to develop my EHM Updater, 2) I help maintain an unofficial roster update for
EHM 2007, 3) I'm a researcher for Franchise Hockey Manager and 4) I run my own EHM/FHM website. On top of that, I have a pretty
busy job. So I tend to rotate my tasks somewhat. My current priority is to get some basic functions up and running for the CM Updater
(at which point I'll release it for testing) and then I'll probably do some roster work and EHM Updater work before returning to spend
some more time on the CM Updater. I'm also working on creating a shared library of code that both the CM and the EHM Updater will
share - so when I improve core functions for one Updater, the other Updater will benefit too.
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It looks promising, but I just truly hope that to use this program I won't need to have admin rights...

 Originally Posted by Rapinoe 

Archie - a question/suggestion: are you planning to include that 'count' screen that shows the number of players in each league with minimum,
maximum and average CAs? I think that could also be quite useful here too.

 Originally Posted by milo 

archibald, since this tool can be very very helpful for the update team, can you also add any features requested by the team?

if so, you and the team could cooperate to make this tool as best we can
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Glad to read it and thank you for your job!
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 Originally Posted by archibalduk 

If your database is located in C:/Program Files(x86)/.../ then yes you'd need to use Run as Admin (otherwise you end up with ghost copies of
your DB in your Roaming folder).

BUT, you can easily avoid this by coping your DB (i.e. all of your .dat files plus player_setup.cfg) to another folder temporarily. E.g. if you move
it to a folder on your Desktop or My Documents then you don't need to use Run as Admin. It's only when it's in Program Files where you have to
worry about admin rights.
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Seems promising :-)

Is one of the intended usages to allow the update team to work in parallell? I.e. make it possible to, say, let one updater take care of
Italian leagues and another one Spain -- and sometime before release, dump those leagues as CSV files, and then import them into a
master database?
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Yes, that's exactly right.

Each researcher could work on their own blank spreadsheets. They just list the attribute/transfer changes and players/non-players
that need to be created in their own spreadsheets and send them to the person who has the DB. The person who has the DB imports
the spreadsheets into the DB using the Updater. This is how we have been editing EHM for about 3 years now - we have been able to
achieve a lot more than just one person having to make all the changes manually using the Pre-Game Editor.

Here are some screenshots of some of the EHM Updater spreadsheets we use (they might give you an idea of how the spreadsheets
work in the EHM Updater and roughly how I plan to get them to work in the CM Updater):

In the screenshot above, when this spreadsheet is imported into a DB using the Updater: Andreas Nodl's date of birth will be changed
to 1st April and the Stickhandling and Wristshot attributes for Thomas Pock will be changed to 14 and 20 respectively.

In the screenshot above, when this spreadsheet is imported into a DB using the Updater:

* Matt Walker will be moved to the New York Rangers' roster and his salary will be set to $5m per year;
* Brent Burns will be moved to the Worcester Sharks' roster;
* Filip Kuba will be retired (and set to a free agent);
* Todd McLellan will be set to a free agent (UFA = free agent in ice hockey terminology).

The screenshot above is of the staff_new.xml/csv spreadsheet which is used for inserting new players/non-players into the DB.
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Seems promising :-)

Is one of the intended usages to allow the update team to work in parallell? I.e. make it possible to, say, let one updater take care of Italian
leagues and another one Spain -- and sometime before release, dump those leagues as CSV files, and then import them into a master
database?
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we all work here in our spare time 

thank you very much, hope we can really collaborate 

 Originally Posted by archibalduk 

Yes, I would be more than happy to do so. The aim of my tool is to make DB editing easier for the guys who maintain the excellent roster
updates. So please do post suggestions and I'll see what I can do. I won't make any promises, but it would be really useful to know what sorts
of things would help the roster update team because then I can prioritise those aspects.

I must however stress that I do have a heavy workload and so progress on this tool will be very stop-start. Just to give you an idea of the other
things I have on my plate: 1) I'm continuing to develop my EHM Updater, 2) I help maintain an unofficial roster update for EHM 2007, 3) I'm a
researcher for Franchise Hockey Manager and 4) I run my own EHM/FHM website. On top of that, I have a pretty busy job. So I tend to rotate
my tasks somewhat. My current priority is to get some basic functions up and running for the CM Updater (at which point I'll release it for
testing) and then I'll probably do some roster work and EHM Updater work before returning to spend some more time on the CM Updater. I'm
also working on creating a shared library of code that both the CM and the EHM Updater will share - so when I improve core functions for one
Updater, the other Updater will benefit too.
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Great stuff mate. I am looking forward to testing it.
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I've actually put my league patch on hold because this should make it much less time-consuming. Waiting on the edge of my seat.
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Don't know if you are taking requests but these 2 are sorely missing from the official editor (and a lot of other tools)

Filter Free Players
Filter Free Staff
Filter Players by Continent
Filter Staff by Continent

Champman0102.co.uk Facebook Page
13000 followers and rising

November 2020 Data Update Out Now
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Filter Stadia by Country..... it can only be done by City and it's a huge pain when making patches..... maybe just for me though
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Nope, that's a good one CF 

Champman0102.co.uk Facebook Page
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November 2020 Data Update Out Now
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@archibalduk - just in case you don't know already. If you ever try opening the original 3.9.68 data you might notice that staff.dat is
in a different format; staff preferences are stored in the person data rather than as a 4th 'file'. When I first found this out it freaked
me out as my code just stopped working after I had re-installed CM. Running the data through the editor once will modify staff.dat to
be in 4 files again.
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Do you mean being able to look at the data in a spreadsheet and being able to filter by that data? Assuming that's the case:

Filter Free Players - ALREADY ADDED
Filter Free Staff - ALREADY ADDED (You can also filter by job for club and job for nation, league contracted, etc etc)
Filter Players by Continent - I CAN ADD THIS, NO PROBLEM (IT'LL TAKE ABOUT 5 MINUTES' WORK)
Filter Staff by Continent - I CAN ADD THIS, NO PROBLEM (IT'LL TAKE ABOUT 5 MINUTES' WORK)

Filter Stadia by Country - ALREADY ADDED (YOU CAN ALSO FILTER BY CONTINENT)

Here are some screenshots of the exported xml files (the csv files are the same but they don't have the nicely formatted column widths
and coloured frozen pane header row):
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Don't know if you are taking requests but these 2 are sorely missing from the official editor (and a lot of other tools)

Filter Free Players
Filter Free Staff
Filter Players by Continent
Filter Staff by Continent

 Originally Posted by Craig Forrest  

Filter Stadia by Country..... it can only be done by City and it's a huge pain when making patches..... maybe just for me though
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Note that the exported_staff spreadsheet is a work in progress (I still need to pre-set the column widths). Owing to the huge amount
of data (over 100,000 players and staff), the resultant xml file is about 230mb (and it takes a whopping 17 seconds to generate -
whereas exporting city/club/stadium/etc data takes a fraction of a second). The csv file will be smaller, but it's still a bit of a pain. I
think I'll remove the staff attributes from the exported_staff spreadsheet and instead export these with the player and non-player
attributes spreadsheets.
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Thanks for pointing that out.  I hadn't realised that (I've been working with the March roster update).

I'll proceed on the basis of only supporting the staff.dat with 4 "sub-files" for the time being. Is the Version number different in the
index.dat file where the preferences data is stored in the person data?

Something that bothers me about index.dat is that if your index file is ever corrupt, the staff.dat file is essentially lost because you
need the offsets in order to index the 4 "sub-files". I don't like relying on index.dat, instead I prefer just getting the Updater to figure
out the index on the fly (i.e. by looking at the file sizes of each file and figuring out the index itself). I think it should be fairly
straightforward to calculate the offsets of where each sub-file begins from reading staff.dat. Then I'll be free from having to rely on
index.dat.
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@archibalduk - just in case you don't know already. If you ever try opening the original 3.9.68 data you might notice that staff.dat is in a
different format; staff preferences are stored in the person data rather than as a 4th 'file'. When I first found this out it freaked me out as my
code just stopped working after I had re-installed CM. Running the data through the editor once will modify staff.dat to be in 4 files again.
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Nice job and cheers for the additions. So far the Export options look good, any luck with re-importing or have you got that far?
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That the solution I've gone for. I don't recall checking the version number on the original data but I expect it will be different (1 instead
of 2 presumably).

My code relies on index.dat - even to the extent of using the file names (staff.dat, club.dat etc). Also allows data to be 'ignored', e.g.
one of my tools edits index.dat by making it think there is only 1 staff history - which makes the game load quicker (at the expense of
showing the histories in game).

Not sure how you'd work out numbers based on file size but you could manually scan the file, e.g. read 4 bytes skip 106 bytes, read 4
bytes, skip 106 bytes - then when the last 4 byte number is not 1 above the previous 4 byte number you know that you've got to the
end of the person section.
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07-07-14, 09:54 PM

Join Date:
Location:

Posts:

04-03-12

Serbia,Belgrade,Zemun
984

looks great...spreadsheet is almost exact as spreadsheet i used to insert data via JL
uber tool...
how fast will be inserting option?just for comparing,JL uber tool can insert around 5000
staff with full attributes under 10 minutes...
just suggestion:

option for adding clubs,cities,stadiums to DB via spreadsheet (same as JL tool Uber
Parser does)
option for altering club and nation histories via spreadsheet

Also...there is a handy option in Uber Parser tool (update club option) through .csv file
that allows u to relocate great amount of clubs at once from league to league (specially
great for league patching),so i wonder if something like that can be included.
thanks for the great work m8!
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No importing quite yet. I think that might not be until next month. I'm just finishing off data deletion and the free agent utility. Then I'll
release it for people to test.

Regarding data import/filtering - if there is anything else you need, please let me know. Adding data export stuff is a simple 10 minute
job.

Yeah I used to rely on index.dat very heavily too. However, I now load the full DB each time into individual classes, so I can't rely on
index.dat any more.

Regarding the staff files - It would be a case of tracking the ID numbers of each entry read until you reach 0 again (at which point you
know the next sub-file begins). I think it's a bit of overkill, but maybe I'll look at it once other more important things are done.
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 Originally Posted by Dermotron 

Nice job and cheers for the additions. So far the Export options look good, any luck with re-importing or have you got that far?

 Originally Posted by JohnLocke 

That the solution I've gone for. I don't recall checking the version number on the original data but I expect it will be different (1 instead of 2
presumably).

My code relies on index.dat - even to the extent of using the file names (staff.dat, club.dat etc). Also allows data to be 'ignored', e.g. one of my
tools edits index.dat by making it think there is only 1 staff history - which makes the game load quicker (at the expense of showing the
histories in game).

Not sure how you'd work out numbers based on file size but you could manually scan the file, e.g. read 4 bytes skip 106 bytes, read 4 bytes,
skip 106 bytes - then when the last 4 byte number is not 1 above the previous 4 byte number you know that you've got to the end of the person
section.
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I can't remember the exact numbers, but IIRC the EHM Updater can insert around 100,000 player career history entries in under a
minute (the EHM career history entries are *slightly* larger than the CM history structure, so I'd hope the CM Updater to be marginally
quicker).

Adding and updating data via spreadsheets will come with time. Player, non-player and official attributes, staff data (e.g. contract
data) updating/editing and player/non-player and player career history insertion are my first tasks. But I can't commit to any ETA I'm
afraid.
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 Originally Posted by djole2mcloud 

how fast will be inserting option?just for comparing,JL uber tool can insert around 5000 staff with full attributes under 10 minutes...
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Just out of curiosity, what programming language do you use?
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I use C++ and the Qt Library (Qt makes GUI programming much easier than pure C++).
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If you're interested, here are a couple of features I have planned to implement in my CSV tool:

Attributes can be set using a 5-star rating system as well as being set explicitly, e.g. you can enter '*' to '****** which will convert a
random number as follows: 1-5, 4-9, 10-13, 14-17, 18-20. I have designated dirtyness and injury proneness as 'bad' attributes - so if
you enter ***** you'll get a low value rather than a high.

For club kit colours I'm planning to allow the user to use the name of another club as well as the colour names, e.g. it would accept
'Man Utd:away' then copy the values from Man Utd's away kit.
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archibald, can you also add the option to export stadiums attached to clubs that use them?

i mean extracting a list of stadiums like this:

etihad - man city
emirates - arsenal
anfield - liverpool

i know it's not so useful maybe but as i'm a maniac of tables, it would save me some work before every release
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That's a really neat idea about the team colours. I might "borrow" that idea for my EHM Updater!!

The rating system is intriguing. Something I'd been thinking about for the EHM Updater was to create some player profiles or roles
which weight the attributes according to the player's profile (e.g. a physical attacking winger). I.e. you select the role and then the
tool will create an appropriate set of attributes according to this role and the CA.

Currently it lists all of the clubs and says which stadium is attached to each club. Is this what you mean, or are you looking for a
spreadsheet that lists every stadium and says how many teams play at that stadium?

 Originally Posted by JohnLocke 

If you're interested, here are a couple of features I have planned to implement in my CSV tool:

Attributes can be set using a 5-star rating system as well as being set explicitly, e.g. you can enter '*' to '****** which will convert a random
number as follows: 1-5, 4-9, 10-13, 14-17, 18-20. I have designated dirtyness and injury proneness as 'bad' attributes - so if you enter *****
you'll get a low value rather than a high.

For club kit colours I'm planning to allow the user to use the name of another club as well as the colour names, e.g. it would accept 'Man
Utd:away' then copy the values from Man Utd's away kit.

 Originally Posted by milo 

archibald, can you also add the option to export stadiums attached to clubs that use them?

i mean extracting a list of stadiums like this:

etihad - man city
emirates - arsenal
anfield - liverpool

i know it's not so useful maybe but as i'm a maniac of tables, it would save me some work before every release

08-07-14, 07:08 PM

Join Date:
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the second one 

i need it to know which stadiums are not attached, not needed.

currently i extract the list of stadiums, compare it to the list of clubs with their stadiums deleting those used by clubs, then i compare
it again to the list of nations with their stadiums deleting those used by national teams.

what remains is what i was looking for, the list of unattached stadiums.

same for cities and related stadiums...
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 Originally Posted by archibalduk 

Currently it lists all of the clubs and says which stadium is attached to each club. Is this what you mean, or are you looking for a spreadsheet
that lists every stadium and says how many teams play at that stadium?
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Ok I see. Leave it with me. I'll see what I can do!
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Is this what you had in mind?

This lists all clubs and nations attached to each stadium. It also lists blank stadia (just use the Data -> Sort or Auto-Filter in Excel/etc
to filter them out). There are 2,037 unattached stadia (out of 9,490 stadia) in the March DB update.

What is the deal with the stadium named "Player and Comp History File Club"? Is it a game-critical stadium? It has 316 stadia attached
to it.

Let me know if you need anything else displayed on this spreadsheet.

Assuming this is what you had in mind, I'll get started on the stadia by cities spreadsheet later this week/weekend.

 Originally Posted by milo 

the second one 

i need it to know which stadiums are not attached, not needed.

currently i extract the list of stadiums, compare it to the list of clubs with their stadiums deleting those used by clubs, then i compare it again to
the list of nations with their stadiums deleting those used by national teams.

what remains is what i was looking for, the list of unattached stadiums.

same for cities and related stadiums...
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2037!?!?!?

i was sure i deleted them all in the previous release... or maybe i deleted unattached cities... can't remember now 

yes archibald, it's just what i have been wishing for, thank you so much 

the "player and comp..." stadium is a fictional stadium that help us not to delete clubs needed for history files, basically we set that
stadium to extinct clubs in db so that if you wanted to delete the club you can see you don't have to 

 Originally Posted by archibalduk 

Is this what you had in mind?

This lists all clubs and nations attached to each stadium. It also lists blank stadia (just use the Data -> Sort or Auto-Filter in Excel/etc to filter
them out). There are 2,037 unattached stadia (out of 9,490 stadia) in the March DB update.

What is the deal with the stadium named "Player and Comp History File Club"? Is it a game-critical stadium? It has 316 stadia attached to it.

Let me know if you need anything else displayed on this spreadsheet.

Assuming this is what you had in mind, I'll get started on the stadia by cities spreadsheet later this week/weekend.
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I've finished the spreadsheet showing stadia grouped by city. Melbourne has the most stadia attached (64 stadia). 496 of 7229 cities
don't have a stadium attached.
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I've been making a little more progress with the Updater this weekend. The lasted feature I've transferred across from the EHM Updater
is a screen which shows some stats about the Current Ability ratings of players in each league. It shows stats such as the league
average as well as how many players have a zero CA:

I'm hoping to have a version online within the next couple of days. I had hoped to have it uploaded today, but the Delete Staff
function is still buggy. It might be that I won't have the Delete Staff function working before I release it (I need to take some time off
from working on the Updater for a week or two to work on some other things).

13-07-14, 06:44 PM

Join Date:
Location:
Posts:

15-10-12
Grantham

381

Just a thought as it was something I could have done with a few months ago when I was looking at stadiums. Not just viewing
stadiums by city, but also by country. Is this possible?
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I've finished the spreadsheet showing stadia grouped by city. Melbourne has the most stadia attached (64 stadia). 496 of 7229 cities don't have
a stadium attached.
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Yeah, that's not a problem. I'll add a Nation column to the stadia spreadsheets.
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 Originally Posted by Golly 

Just a thought as it was something I could have done with a few months ago when I was looking at stadiums. Not just viewing stadiums by city,
but also by country. Is this possible?
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Oooh I love you. I already have a son called Archie, but if I didn't I would name any further son I might have in your honour.

 Originally Posted by archibalduk 

Yeah, that's not a problem. I'll add a Nation column to the stadia spreadsheets.
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Haha that's quite a compliment! 

Give me a shout if there's anything else you'd like to export from the DB in spreadsheet form. It's pretty straightforward to add
exporting functions.

#43

Reserve Team Player
archibalduk 
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Oooh I love you. I already have a son called Archie, but if I didn't I would name any further son I might have in your honour.
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This is such an amazing project, hats off to you Archi.
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As promised, here is version 0.0.1 of the CM 01/02 Updater: http://1drv.ms/1oNV0aY

Please note that the Updater is still in a beta state. The Updater has not yet been fully tested. I'm uploading it now because I don't
think I'll have much time to do more work on the Updater for a week or two. If anybody tests it out then please let me know what does
or does not work (exporting should work fine, but the other functions may be buggy - I know for certain that parts of the Erase DB
function is buggy - see more details below).

It is imperative that you backup your database before editing it using the Updater. You do not need to backup your database if you
just use the exporting functions and don't click on File->Save afterwards. It's only if you're going to use the File->Save function that
you need to first backup your database. Alternatively, you can use File->Save As to save the database in an different location.

Here are some notes:

Minimum Requirements
You must have the Microsoft Visual C++ 2010 Redistributable Package installed otherwise you'll encounter a crash when you
try to load a database in the Updater. Here's the download link: http://www.microsoft.com/en-us/downl...s.aspx?id=5555

Installation
Simply extract the contents of the downloaded zip file into a folder of your choice. You'll see that the zip file consists of the exe and a
number of dll files (including a 'platforms' sub-folder which consists of 3 further dll files).

If you're going to edit and save a database located in C:/Program Files/../ then you must use 'Run as Admin' to load the Updater -
otherwise it won't be able to save your database properly (as with any other editor, if you don't use Run as Admin for a database in
Program Files, you'll end up with a shadow copy in your /Users/Roaming/ folder which is a real pain). Also, you must always use 'Run as
Admin' if you install the Updater to C:/Program Files/../ (otherwise it won't be able to save your settings to its config file).

I have Windows 7 on my laptop and so this is what I've tested the Updater on. However, I keep an old XP installation via a virtual
machine and have briefly tested the Updater on XP (it seems to run ok).

CSV and XML Spreadsheets
You can export data to either CSV or XML file formats. You'll see in the status bar (bottom right corner of the window) that it says
'CSV' or 'XML' depending on your current setting. Click on Spreadsheet->Use CSV Spreadsheets if you want to use CSV rather than
XML (and click on it again to re-enable XML). Also, when you click on the Export button you'll see from the Save File dialogue window
that you can choose the file extension regardless of your CSV/XML setting. The CSV/XML setting is just a quick way of setting the
default.

The advantages with CSV files are:
- They're smaller in file size than XML;
- They are fully compatible with OpenOffice/LibreOffice as well as Excel.

The advantages with XML files are:
- They have nicer formatting by default which the Updater utilises - such as frozen header panes and pre-set column widths;
- They are usually compatible with OpenOffice/LibreOffice. The only time these programmes struggle is if you load particularly large XML
files (such as the exported staff and staff history spreadsheets);
- They are full compatible with Excel. Unlike OpenOffice/LibreOffice, Excel doesn't seem to have any problem with large XML files;
- They fully support UTF (whereas CSV is better suited to ASCII - not even Excel seems to particularly like UTF CSV files - at least
from what I've tested). I don't think this is really an issue for CM because I haven't come across any UTF characters thus far (unlike
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from what I've tested). I don't think this is really an issue for CM because I haven't come across any UTF characters thus far (unlike
EHM);
- Unlike CSV files, they don't have different locale/regional types (see below for more details).

A particular drawback with CSV files is that the delimiter varies according to your computer's locale (or regional settings). A CSV file is
simply a text file with a set delimiter (or separator) which acts as a column/cell separator. Computers with a British, Canadian or US
locale use commas as delimiters. Most other countries use a semi-colon as a delimiter (because those countries use a comma as a
decimal point). There is also a third option which OpenOffice/LibreOffice often uses by default - tab delimiters.

You can see what delimiter your system uses by clicking on the Spreadsheet menu. You'll see at the bottom of the menu, it'll say in
grey text "CSV Delimiter: " followed by either "comma" or "semi-colon".

The various CSV delimiters is not a problem for the Updater because it automatically detects your locale and will export using the
appropriate delimiter. It will also auto-detect the delimiter of a given file when the Import function is up and running. The difficulty
arises when you want to share a CSV file with somebody from a different locale - it won't appear correctly in their
Excel/OpenOffice/LibreOffice. To solve this problem, you can use Spreadsheet->Convert CSV Delimiters to convert the delimiters for
any CSV file.

CSV and XML Spreadsheets - Which Should You Use?
The above section was a bit long-winded, so I thought I'd cut to the chase here: Given the choice, I would go with XML files where
you can. The only time you might want to consider using CSV is if you're exporting a particularly large file (e.g. the staff spreadsheet)
because when using XML the resultant file will be approx 170 mb (it takes around 15 secs to export). Compared with using CSV where
the export file is 15 mb (4 secs to export). To get around the large size of the staff XML file, you could load it in Excel/etc and save it
as an XLS/XLSX as they are smaller than XML files.

Export
This is no doubt obvious:- Use the drop-down menu to select what you want to export and then press the Export button.

I haven't had the chance to recently test the Export All option, but I'd expect it to take perhaps around a minute with XML and maybe
about 30 secs with CSV.

Note that I need to tidy up the column headings in the exported attributes spreadsheet (for both players and non-players IIRC).

I plan to add additional export options in the future. If there is something in particular you'd like to be able to export then please let me
know.

Erase Data
This function is buggy and still needs more testing and work.

CM doesn't like having any blank tables. To get around this, the Updater will erase the data and then create a single entry. From
memory, this seems to work ok for erasing officials, staff career history and staff competition/awards history (note that when I say
"staff" I mean both players and non-players).

Erasing club competition history doesn't cause a crash but it does cause a couple of errors to pop-up during game creation. I would
guess that it's because certain competitions must have at least one entry of history. I'll need to test out this theory.

Deleting staff causes a crash without any error message. I need to figure this one out. Presently the Updater will create a single staff
member who is a player/coach (thereby ensuring that there is a single entry in both the player and non-player tables). I thought this
would work (as it does for EHM), but alas it crashes. Hence using the "Create a blank database" option from the drop-down menu also
causes a crash (because it involves deleting staff). Hopefully I'll get to the bottom of this (it might be because the Updater doesn't
update the staff counts in the nations table yet).

Free Agent Utility
Seems to work, but more thorough testing is needed.

Year Adjustment
Seems to work, but more thorough testing is needed.

Current Ability Ranges
This table shows the range of Current Ability ratings for players contracted to each league. You can export this to a spreadsheet via
the Export button below the table (as you can also do so for the Index table).

Last edited by archibalduk; 18-07-14 at 08:12 PM.
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Jiminy fucking jilickers

4 secs and not 40 minutes, beautiful
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« New guy, new league | Skills to Learn for Patching/RE? »

Join Date:
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Posts:

15-12-11
Your Mother

29,995

Insanely quick, top effort archie 

I would suggest adding the CA/PA/HR/CR/WR to the exporter when you get a chance (and the others stuff I guess). So quick to export

Wonderful start 

Last edited by Dermotron; 17-07-14 at 10:43 PM.
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Apologies, just seen that was missing for Staff, not Players, truly awesome stuff
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I'm on my mobile right now, but forgot to mention that if the Updater doesn't run then you'll need to install the Microsoft Visual C++
2010 Redistributable. I'll post a link to it tomorrow.

Dermotron - my next task is to tidy up the player and non-player attribute spreadsheets with better column titles. IIRC CA/PA/Rep are
already listed in those spreadsheets, but they might not be clearly labelled right now. [Edit - I see you've found them now ]

#49

Reserve Team Player
archibalduk 
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Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

One small change for future usage mate, the history exporter should probably use Club Shortname instead of Longname since thats
what the History Tool that put them there uses  

Of course, if you are developing your own History Tool/History Importer that's no big issue really 
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Canada

608

Hmm, random thought here: might it work to do it such that you can choose to delete
only staff of a specified nationality? That way, one could add some staff that is, say,
East German, before you start work, then delete all the others. It'd take a bit longer but
still much quicker than 200 at a time like with the official editor!
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Rapinoe 

 Originally Posted by archibalduk 

Erase Data
This function is buggy and still needs more testing and work.

CM doesn't like having any blank tables. To get around this, the Updater will erase the
data and then create a single entry. From memory, this seems to work ok for erasing
officials, staff career history and staff competition/awards history (note that when I say
"staff" I mean both players and non-players).

Erasing club competition history doesn't cause a crash but it does cause a couple of
errors to pop-up during game creation. I would guess that it's because certain
competitions must have at least one entry of history. I'll need to test out this theory.

Deleting staff causes a crash without any error message. I need to figure this one out.
Presently the Updater will create a single staff member who is a player/coach (thereby
ensuring that there is a single entry in both the player and non-player tables). I thought
this would work (as it does for EHM), but alas it crashes. Hence using the "Create a blank
database" option from the drop-down menu also causes a crash (because it involves
deleting staff). Hopefully I'll get to the bottom of this (it might be because the Updater
doesn't update the staff counts in the nations table yet).

18-07-14, 06:16 AM
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05-06-12
1,032

Opened database, got the progress bar but when it got to the end the application crashed. No error message.

Try twice - second time was much quicker but same result.
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Could you upload your DB so I can test it out? Alternatively you can email it to me - archibalduk at gmail dot com.

Does the progress bar disappear before it crashes? If not, can you see what text is displayed above the progress bar at the time it
crashes?

 Originally Posted by JohnLocke 

Opened database, got the progress bar but when it got to the end the application crashed. No error message.

Try twice - second time was much quicker but same result.

18-07-14, 12:05 PM

Join Date:
Location:

Posts:

04-03-12

Serbia,Belgrade,Zemun
984

same for me...running 3.9.68 at XP
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djole2mcloud 

 Originally Posted by JohnLocke 

Opened database, got the progress bar but when it got to the end the application crashed. No error message.

Try twice - second time was much quicker but same result.

18-07-14, 04:19 PM

Join Date:
Posts:

02-03-12
3,608

just checked it archibald, great great tool, thank you so much 

i have also found a few errors or things that can be improved:

1. in the players file there are 2 rows showing the player & staff ID number
2. birthdates are showed in the m/d/y format, can you change it to d/m/y like in the staff file?
3. first and second nationalities are showed as numbers (i suppose the ID of the nation), can't you make it show the name?
4. club contracted column shows the long name of a club, can you make it show the short name?
5. in the players file the ''job for club'' columns shows only the non-playing job, can you also add the player one (i mean showing
player/manager instead of player only)?
6. there is a column showing the morale (only 0 and 2 values), what is that?
7. when the player has no date of birth but only year of birth in the db the file shows nothing, can you make the year of birth appear
like in the staff file?
8. columns of international caps, international goals, contract start date, contract end date, wage, mental traits (adaptability, etc.),
the nation where the club of the player is from are missing, can you add them?

9. in the rosters file all the columns are filled with numbers, mainly -1

10. in the exported stadiums (clubs by stadium) file nations are duplicated (i.e. 2 brazils play at maracana) 

11. can you make all the non-players attributes be showed in the staff file?

also, we often use filters on excel, can you remove the double heading on the top? (e.g. in the history file you have 1 row with name
and 1 with first name, second name and common name) this way filters don't work and we must delete one of the headings everytime.

sorry for been annoying 
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Can you both try using the March 2014 roster update? That'll help determine whether it's a DB issue or a system/software issue. If the
March 2014 update doesn't work then it's a system/software issue.

Assuming it's a system/software issue (i.e. you still get a crash if you try using the March 2014 roster update), try both of the
following:

- Install the Microsoft Visual C++ 2010 Redistributable Package (I think this not being installed might be the reason for the crash):
http://www.microsoft.com/en-us/downl...s.aspx?id=5555
- If the Redistributable Package doesn't solve the issue, make sure you have the latest .NET Framework installed:
http://www.microsoft.com/net/downloads

If it turns out to be a DB issue, please upload your DB or email it to me - archibalduk AT gmail DOT com

I'll respond to the other posts shortly. 

 Originally Posted by JohnLocke 

Opened database, got the progress bar but when it got to the end the application crashed. No error message.

Try twice - second time was much quicker but same result.

 Originally Posted by djole2mcloud 

same for me...running 3.9.68 at XP

18-07-14, 08:09 PM

Join Date:
Location:

Posts:

04-03-12

Serbia,Belgrade,Zemun
984

yes,with newest update it works perfectly...
Import option still is not in funcion?
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That's pretty complicated I'm afraid. The Erase Staff function simply deletes all of the relevant data and pointers. Deleting just a
selection of staff is more complex as it involves updating all of the various pointers in other tables. It's something I'd like to include in
the Updater eventually but it's more a long term goal (I already have a similar feature in the EHM Updater which will prove a useful
starting point).

I'll look into adding an option so that you can choose whether to export using long names or short names.

Not annoying at all!  I'm really grateful for the feedback - it'll help me ensure that the Updater is as useful as possible. Here are my
comments:

1. in the players file there are 2 rows showing the player & staff ID number

Yeah, I need to correct all of the headings in the player attributes spreadsheet. 

2. birthdates are showed in the m/d/y format, can you change it to d/m/y like in the staff file?

That's a typo (again because I need to correct all of the headings in the player attributes spreadsheet). It is actually listed in d/m/y
format; it's just that the headings are wrong.

I hadn't intended to leave the player attributes spreadsheet in a half-finished state, but I just ran out of time so thought it's better to
get it uploaded for testing now rather than wait potentially another two or three weeks before I have free time again.

3. first and second nationalities are showed as numbers (i suppose the ID of the nation), can't you make it show the name?

My mistake. I'll fix that.

#58

Reserve Team Player
archibalduk 

 Originally Posted by Rapinoe 

Hmm, random thought here: might it work to do it such that you can choose to delete only staff of a specified nationality? That way, one could
add some staff that is, say, East German, before you start work, then delete all the others. It'd take a bit longer but still much quicker than 200
at a time like with the official editor!

 Originally Posted by Dermotron 

One small change for future usage mate, the history exporter should probably use Club Shortname instead of Longname since thats what the
History Tool that put them there uses  

Of course, if you are developing your own History Tool/History Importer that's no big issue really 

 Originally Posted by milo 

jsorry for been annoying 
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4. club contracted column shows the long name of a club, can you make it show the short name?

I'm going to try to add an option so that you can choose to export either long or short names.

5. in the players file the ''job for club'' columns shows only the non-playing job, can you also add the player one (i mean
showing player/manager instead of player only)?

As far as I can see, it does show the full job. Can you give me an example of where a player/manager is listed as only a player? I'll then
check out what's going on.

6. there is a column showing the morale (only 0 and 2 values), what is that?

It sets the player's morale. However, it is only used in saved games. The reason for including it is so that if I add saved game support,
we'll be able to see (and edit) players' morale.

7. when the player has no date of birth but only year of birth in the db the file shows nothing, can you make the year of birth
appear like in the staff file?

Thanks - I had intended to include YoB. I'll fix that.

8. columns of international caps, international goals, contract start date, contract end date, wage, mental traits
(adaptability, etc.), the nation where the club of the player is from are missing, can you add them?

Do you mean you want to see this in the player attributes spreadsheet (in addition to all this info already being present in the staff
spreadsheet)? I can certainly do that, but it'll make the player attributes spreadsheet file size somewhat larger.

9. in the rosters file all the columns are filled with numbers, mainly -1

Sorry, I should have mentioned that the rosters spreadsheet is just for my testing. It shows all of the staff IDs of players contracted
to each team (I need to see this for testing in order to make sure the Updater correctly updates the rosters). I'll eventually replace the
IDs with player/non-player names.

10. in the exported stadiums (clubs by stadium) file nations are duplicated (i.e. 2 brazils play at maracana) 

One of those teams will be the U-21 team. I'm glad you reminded me of this. I'll make sure the Updater adds "U-21" to the U-21 nation
teams.

11. can you make all the non-players attributes be showed in the staff file?

They'll go in a separate non-player attributes spreadsheet. The staff attributes (i.e. those attributes which both players and non-
players have) will be shown in the player and non-player attributes spreadsheets.

also, we often use filters on excel, can you remove the double heading on the top? (e.g. in the history file you have 1 row
with name and 1 with first name, second name and common name) this way filters don't work and we must delete one of the
headings everytime.

Ideally I'd rather keep the dual header rows as it makes it a little easier to display column headings.

That said, you can filter with dual header rows (I do it all the time). Just select the second header row - i.e. click on the "2" in the
spreadsheet in Excel and then click on Data -> Autofilter (or Data -> Filter if you're using Excel 2007+ IIRC):



18-07-14, 08:10 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Excellent! Thanks for letting me know. I'll update my original post. 

No, the import function isn't working yet. It's near the top of my list for the next update (hopefully August).

#59

Reserve Team Player
archibalduk 

 Originally Posted by djole2mcloud 

yes,with newest update it works perfectly...
Import option still is not in funcion?

18-07-14, 09:52 PM

Join Date:
Location:

Posts:

04-03-12

Serbia,Belgrade,Zemun
984

it really looks great...!
is it possible to add a option for editing histories(club comps,national comps...)

#60

Programmer
djole2mcloud 

18-07-14, 11:43 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

I've added a setting so that you can choose whether to use long or short names when exporting/importing data.

Yes, that's the plan!

#61

Reserve Team Player
archibalduk 

 Originally Posted by djole2mcloud 

it really looks great...!
is it possible to add a option for editing histories(club comps,national comps...)

19-07-14, 01:07 AM

Join Date:
Location:
Posts:

21-06-14
Canada

608

Yeah, I didn't think that would really be viable, was just a sudden thought! Not meaning to sound impatient or anything, just am a bit
antsy to get started on "actual" work on my project, and for that I need a blank (no staff at all) DB... 

#62

Backup Player
Rapinoe 

19-07-14, 06:04 AM

Join Date:
Posts:

03-03-12
2,949

I have a no player db, should be in downloads.

#63

VIP
Cam F 

19-07-14, 07:01 AM

Join Date:
Location:
Posts:

21-06-14
Canada

608

Thanks Cam, I have it - but I need no staff at all (players or non-players).

#64

Backup Player
Rapinoe 

19-07-14, 12:03 PM

Join Date:
Posts:

02-03-12
3,608

#65

Director
milo 
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you are right, my mistake 

well, some of those are really important, maybe you can make 2 different types of file, one with main attributes only and another one
(much bigger) with a complete list of attributes? if so we can tell you what's really needed in the small file to update 

great 

thanks for your answers and for your work 

 Originally Posted by archibalduk 

5. in the players file the ''job for club'' columns shows only the non-playing job, can you also add the player one (i mean
showing player/manager instead of player only)?

As far as I can see, it does show the full job. Can you give me an example of where a player/manager is listed as only a player? I'll then check
out what's going on.

 Originally Posted by archibalduk 

8. columns of international caps, international goals, contract start date, contract end date, wage, mental traits (adaptability,
etc.), the nation where the club of the player is from are missing, can you add them?

Do you mean you want to see this in the player attributes spreadsheet (in addition to all this info already being present in the staff
spreadsheet)? I can certainly do that, but it'll make the player attributes spreadsheet file size somewhat larger.

 Originally Posted by archibalduk 

also, we often use filters on excel, can you remove the double heading on the top? (e.g. in the history file you have 1 row with
name and 1 with first name, second name and common name) this way filters don't work and we must delete one of the
headings everytime.

Ideally I'd rather keep the dual header rows as it makes it a little easier to display column headings.

That said, you can filter with dual header rows (I do it all the time). Just select the second header row - i.e. click on the "2" in the spreadsheet
in Excel and then click on Data -> Autofilter (or Data -> Filter if you're using Excel 2007+ IIRC):

19-07-14, 08:26 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Sure, will do! 

I might be able to push out an updated version tomorrow with some additional export spreadsheet options (including what you
suggest).

P.s. How would you rather see the player attributes listed in the spreadsheet? Would you prefer them to be ordered alphabetically like
in the Editor and the Player Profile Screen in game or would you rather see them categorised somehow?

Last edited by archibalduk; 19-07-14 at 08:35 PM.

#66

Reserve Team Player
archibalduk 

 Originally Posted by milo 

well, some of those are really important, maybe you can make 2 different types of file, one with main attributes only and another one (much
bigger) with a complete list of attributes? if so we can tell you what's really needed in the small file to update 

19-07-14, 09:04 PM

Join Date:
Posts:

03-03-12
139

This looks really good. Thanks for working on this archibalduk. Just wondering if this editor will work with older cm3 versions as well? I
hope so...

#67

Hot Prospect for the Future
Vikingfk 

20-07-14, 11:43 AM

Join Date:
Posts:

02-03-12
3,608

#68

Director
milo 
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personal opinion is to show them as they are in the editor from acceleration to work rate.
the only difference i would like to see is left and right foot at the beginning of the list (before acceleration)

 Originally Posted by archibalduk 

Sure, will do! 

I might be able to push out an updated version tomorrow with some additional export spreadsheet options (including what you suggest).

P.s. How would you rather see the player attributes listed in the spreadsheet? Would you prefer them to be ordered alphabetically like in the
Editor and the Player Profile Screen in game or would you rather see them categorised somehow?

20-07-14, 02:34 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

I'm afraid it's not in my immediate plans - sorry.

Thanks. Will do!

#69

Reserve Team Player
archibalduk 

 Originally Posted by Vikingfk 

This looks really good. Thanks for working on this archibalduk. Just wondering if this editor will work with older cm3 versions as well? I hope
so...

 Originally Posted by milo 

personal opinion is to show them as they are in the editor from acceleration to work rate.
the only difference i would like to see is left and right foot at the beginning of the list (before acceleration)

20-07-14, 04:29 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Here is version 0.0.2: http://1drv.ms/1sBtjc9

If you haven't previously installed the Microsoft Visual C++ 2010 Redistributable Package then make sure you do so (the Updater needs
the Redistributable to run correctly): http://www.microsoft.com/en-us/downl...s.aspx?id=5555

If you already have v0.0.1 installed, just delete the files and replace with the files contained in the v0.0.2 zip file. I recommend
deleting your existing v0.0.1 updater.cfg file as the config settings have changed slightly for v0.0.2.

Many thanks to all of the suggestions from Milo and Dermotron. I have incorporated most of these suggestions (I'll incorporate Milo's
other suggestions in v0.0.3). Here's a rough changelist:

- Improved the player and staff export spreadsheets (fixed mistakes, added additional data, etc);
- Added extended non-player and player spreadsheets which show contract details, etc in addition to attributes (Milo - you'll see these
listed as "Non-Player Attributes (Extended)" and "Player Attributes (Extended)" in the Updater);
- Added a competition history spreadsheet;
- Default spreadsheet file format setting is now on the Settings tab (note that the Settings tab isn't very tidy right now - I'll tidy it up
once I have more settings to add);
- Added a setting on the Settings tab so you can choose whether to export/import files using club's long names or short names (and
there is a corresponding LONG/SHORT item in the status bar);
- Various behind the scenes changes in readiness for adding the first import function;
- Corrected the year adjustment tool so that Club Competition Histories can pre-date 1901 years.

The next version won't be for a few weeks now as I need to change focus to some EHM things. I'll return to the CM Updater in August.
The next planned features are:

- Player and non-player attribute updating (importing);
- Nation staff count updating;
- Name count updating;
- Amend the exported non-players spreadsheet so that it shows appropriate text for Preferred Player Models and Preferred Formation
(currently it just lists ID numbers);
- Add nationality of the contracted club for the non-player, player and staff spreadsheets (I forgot to add this to v0.0.2 - sorry!);
- Add "U-21" to international U-21 team names so they can be distinguished from senior international teams.

#70

Reserve Team Player
archibalduk 

20-07-14, 05:06 PM

Join Date:
Posts:

05-06-12
1,032

#71

Programmer
VIP

JohnLocke 
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The data format is exactly the same in 00/01, so it might work on that, not sure about anything earlier.

 Originally Posted by Vikingfk 

This looks really good. Thanks for working on this archibalduk. Just wondering if this editor will work with older cm3 versions as well? I hope
so...

20-07-14, 05:30 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

There are some annotations to the data structure for 01/02 suggesting that there are some subtle changes following one of the
patches where certain members have changed data type. Is that right - or do the annotations date back from an older CM3?

#72

Reserve Team Player
archibalduk 

 Originally Posted by JohnLocke 

The data format is exactly the same in 00/01, so it might work on that, not sure about anything earlier.

20-07-14, 08:29 PM

Join Date:
Posts:

05-06-12
1,032

The original data may well be different (not sure) but once you've run it through the editor once they are the same.

#73

Programmer
VIP

JohnLocke 

20-07-14, 09:37 PM

Join Date:
Location:

Posts:

04-03-12

Serbia,Belgrade,Zemun
984

looks excellent!

#74

Programmer
djole2mcloud 

20-07-14, 11:05 PM

Join Date:
Location:

Posts:

04-03-12
Jersey City,

NJ...USA
179

Just read about this Updater and it sounds amazing........Thank you very much

#75

Coach
Hoboken16 
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21-07-14, 04:02 PM

Join Date:
Posts:

02-03-12
3,608

just tested it archibald, top top work 

only the CA ranges tool looks buggy (almost all championships have CA high = 127 and
the CA average is wrong too)

#76

Director
milo 

21-07-14, 07:48 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Thanks for pointing that out. It looks like a change I made to the way the Updater handles attributes has broken the CA Range table.
I'll fix it for the next version.

#77

Reserve Team Player
archibalduk 

 Originally Posted by milo 

only the CA ranges tool looks buggy (almost all championships have CA high = 127 and the CA average is wrong too)

22-07-14, 05:34 PM

Join Date:
Posts:

30-06-14
418

Brainstorm:
Could statistics on attribute values be relevant for the update teams? 
Like: how many % of keepers has 18+ handling, and the like?

#78

CM 01/02 Legend
Programmer

Tapani 

22-07-14, 05:42 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995
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Sir Mergements
Director
Manager
VIP
Captain

Dermotron 
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That would be fantastically handy. Totals and percentages would be great. Total/% Vs. Whole DB and Total/% Vs. Eligible Players
(players with attribute other than 0)

Trying to manually calculate it in excel produces huge files that become unusable after awhile.
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I can certainly do that for you. It wouldn't be too difficult at all.

Would you be looking for a spreadsheet which shows these stats on a per league basis (plus a totals row which shows a total for the
whole DB) or simply a details of the DB as a whole? Could you tell me what stats exactly you'd want to see? I understand the Total/%
vs whole DB and all players with >0 atts, but I'm not totally sure exactly which stats you want presented like that?
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Whichever the user wants to choose. 

Something like:

Choose Attribute:
Crossing

Choose Value:
Total = (this is total of players with attribute of select value)

Other options:
Total <
Total >
Total % (percentage of total DB (ex staff)
Total %E (E = Eligible. percentage of total DB where Attribute > 0)

Mental attributes would probably need a player, staff or player & staff option.
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So it's not a spreadsheet per se, but rather you want to pick an attribute and a value and see the stats?
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Either is fine. If you can pump out a spreadsheet with say the attributes in a column on the left and then the headings across the top
that works great too. Possibly even better
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Both approaches are straightforward. Although I think I'm with you - the spreadsheet is possibly the better of the two.

Whilst I think of it, do you have guidelines on the CA range you use for each league? In EHM we have guidelines which indicate the
range and what the average should be. For example, in the NHL the CAs should range from 100 to 190. The CAs of all the players in the
NHL should average 120. "Good" players would get a CA of 160. So the CA range for the NHL can be expressed as Poor = 100, Average
= 120, Good = 160 and Top = 200.

Do you have similar guidelines for CM? The reason I ask is because I have recently been working on adding a research guide template
for the EHM Updater. You select the league and enter the number of players you want to rate (broken down by position i.e. goalie,
defencemen and forwards) and the Updater creates a list of CAs for those players. It isn't intended to be totally scientific, but more a
rough starting point. I could easily transfer this function over the CM Updater. It's still a work in progress in the EHM Updater, but
here's an early screenshot:

And the resultant spreadsheet with the generated CAs:
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Maybe a bar-diagram for attribute values in a certain league? (for a selected attribute)

At least when poking with regen code, I found that the easiest way to see if the regenerated values were "ok" or kept drifting.
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 Originally Posted by archibalduk 

Both approaches are straightforward. Although I think I'm with you - the spreadsheet is possibly the better of the two.

Whilst I think of it, do you have guidelines on the CA range you use for each league? In EHM we have guidelines which indicate the range and
what the average should be. For example, in the NHL the CAs should range from 100 to 190. The CAs of all the players in the NHL should
average 120. "Good" players would get a CA of 160. So the CA range for the NHL can be expressed as Poor = 100, Average = 120, Good = 160
and Top = 200.

Do you have similar guidelines for CM? The reason I ask is because I have recently been working on adding a research guide template for the
EHM Updater. You select the league and enter the number of players you want to rate (broken down by position i.e. goalie, defencemen and
forwards) and the Updater creates a list of CAs for those players. It isn't intended to be totally scientific, but more a rough starting point. I could
easily transfer this function over the CM Updater. It's still a work in progress in the EHM Updater, but here's an early screenshot:

And the resultant spreadsheet with the generated CAs:
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would be great archibald, i currently use the vlookup function in excel and it takes me so long (when i can apply it...).

it would be nice to have a spreadsheet like the CA ranges tool where it lists the number of player higher and lower of the ''right'' CA
range of that league, and of course a more accurate spreadsheet with all the players higher and lower 

is this possible?
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Yeah that's a good idea. I'll see what I can do.

Incidentally, how are attributes stored in the saved game? In EHM many of them are encoded relative to the players' CAs. Is that the
case in CM? And if it is, has anybody ever figured out the formula? I have briefly tried myself but with little success.

The reason I ask is that I'll be looking to bring saved game support to the CM Updater in the near future. It'd be neat if the bar chart,
stats, etc could be used on both the DB and saved games.

If somebody can provide me with a list of the right CAs then yes I can for sure do something for you. All it really involves is simple
maths.

Last edited by archibalduk; 23-07-14 at 09:05 PM.
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Maybe a bar-diagram for attribute values in a certain league? (for a selected attribute)

At least when poking with regen code, I found that the easiest way to see if the regenerated values were "ok" or kept drifting.

 Originally Posted by milo 

would be great archibald, i currently use the vlookup function in excel and it takes me so long (when i can apply it...).

it would be nice to have a spreadsheet like the CA ranges tool where it lists the number of player higher and lower of the ''right'' CA range of
that league, and of course a more accurate spreadsheet with all the players higher and lower 

is this possible?
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I just tried your app to open the original database provided with the game and it crashed just after the loading bar went all the way
through (like it happened to someone else). It crashed every time I tried. Then, I went to cm editor, uploaded the same database and
the editor did some corrections on the database. I saved it and then I tried to open it in your editor and it worked. Maybe this
information could help else with the same problem.
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can't you make it ''open'' so that you need to upload the CA's everytime and it uses those as a reference? i'm saying this because we
could change them (we sometimes did it in the past) and it wouldn't work in that case
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If somebody can provide me with a list of the right CAs then yes I can for sure do something for you. All it really involves is simple maths.
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Thanks!

JL mentioned that the original DB has a slightly different arrangement which is fixed/converted by first running it through the Editor -
after which it'll work with the Updater. I need to add some sort of checking so it either fixes the DB or tells you how to fix it - rather
than it just unhelpfully crashing.

Yes that would make sense. However, I would still need an idea of what the correct CAs are for a couple of leagues at least. This
would help me plan how such a function would work. I.e. do you have similar guidelines as EHM (e.g. a poor, average, good and top
CA), do you look at the range or do you just look at the average?

 Originally Posted by Pucellab 

I just tried your app to open the original database provided with the game and it crashed just after the loading bar went all the way through
(like it happened to someone else). It crashed every time I tried. Then, I went to cm editor, uploaded the same database and the editor did
some corrections on the database. I saved it and then I tried to open it in your editor and it worked. Maybe this information could help else with
the same problem.

 Originally Posted by milo 

can't you make it ''open'' so that you need to upload the CA's everytime and it uses those as a reference? i'm saying this because we could
change them (we sometimes did it in the past) and it wouldn't work in that case
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yes we have something like that for every division, so for example an english premier league player should be around a value according
to his role in the squad, whether he's a top player or a youth team member
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Yes that would make sense. However, I would still need an idea of what the correct CAs are for a couple of leagues at least. This would help
me plan how such a function would work. I.e. do you have similar guidelines as EHM (e.g. a poor, average, good and top CA), do you look at
the range or do you just look at the average?
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The basic data import function is up and running! 

There's still a lot of work to do, but the basic player attribute importing works:
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No idea what this is but looks great and everyone seems to like it. Added a thanks too 
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Inject data into the database from a spreadsheet, Fod. This would allow much easier updating/collation of a database with multiple
scouts.
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I really was impressed with this work, thank you very much and good luck for what will come.

Questions. Will could create COPA ARGENTINA?
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Many thanks indeed! I'm not really sure I understand the question, but the main priority right now is to add/edit/delete things like
players, non-players and staff career history. I don't really have any immediate plans to add competition editing (although I do plan on
doing something similar for EHM 2007 so I *might* be able to pull across the code to the CM Updater - but I'd say that wouldn't
happen any time soon).

By way of an update, I have been making further progress and have both player and non-player attribute editing up and running. I just
need to get the preferred player models and preferred formation settings working. I've also been doing a lot of boring behind the scenes
stuff which I won't bore you with. One concern I have right now is the speed of updating. The CM database is something like 4 or 5
times larger than the EHM database. I plan on doing some testing with the matching algorithm/function (this takes the player's name
and DOB from the spreadsheet and finds the relevant record in the DB) to make sure I can try to make it as quick as possible. I have
two alternative algorithms - one which is nice and tidy and one which is slightly more fiddly to maintain (but potentially faster).

I have also been spending some time on an EHM 2005 Saved Game Viewer for an online league (so users can export their stats, etc in a
format which can then be posted in our forums using the forum's table code). It shouldn't be too much work to pull this into the CM
Updater and so hopefully I'll get some basic saved game viewing working there too. It wasn't something I'd originally planned to do, but
it should be an easy task and so I may as well!
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Sounds like a hashtable to me?
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I plan on doing some testing with the matching algorithm/function (this takes the player's name and DOB from the spreadsheet and finds the
relevant record in the DB) to make sure I can try to make it as quick as possible. I have two alternative algorithms - one which is nice and tidy
and one which is slightly more fiddly to maintain (but potentially faster).
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Yes, that's one of the options I'm looking at.

Currently the function is just iterating through a vector and performing a number of comparisons (e.g. comparing forename, surname
and DOB). However, it involves a couple of function calls with each iteration as I use a custom String class which allows me to control
how the string is formatted (e.g. ignore UTF characters if using csv, ignoring any accents if the user enables the Simple Match setting,
etc). I'm interested to see what impact it has on the speed if I construct a hashtable or vector with the formatted strings before
making the comparison rather than formatting the strings on the fly.

 Originally Posted by Tapani 

Sounds like a hashtable to me?
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Looks like the hashtable could be quicker in this instance. I've been testing using some test data and have found that a hashtable may
be 0.015 secs per lookup faster than a vector. That's quite a lot of time if you're looking to update 70,000 records (i.e. importing
attributes for every player from one DB to another). I expect the actual speed will be different once I've implemented this into my
application (because my test was done in a separate test application), but it certainly looks like it could provide a speed improvement.

I'll keep on testing...
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A great tool Archie!

One question though, as I don't have Microsoft office, I'm stuck with the sub-standard open office, and when I tried open the XML-file,
I got an error saying I need a JER (?) Java enivorment-something), I installed that and now it opens, but there are no data what so
ever in the file. Does anyone know how to open XML in Open Office?

If I try open CSV, the columns get seperated, for example A : Premier : Division, instead of A Premier Division, so I doubt importing will
work.

Ahh, I hate Open Office.

Last edited by zrogba; 07-08-14 at 09:12 PM.
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Yeah it'll be your CSV delimiter settings in OpenOffice.

I would second that recommendation for LibreOffice. A couple of years ago virtually all of the guys who developed OpenOffice left and
setup LibreOffice because IIRC they weren't happy with the lack of progress in OpenOffice. IMO LibreOffice is a better and more
developed version of LibreOffice. Also, the XML files are compatible with LibreOffice.
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For comparing string I would suggest using a trie.
The time complexity is O(|s|) where s is the string length and not O(n) where n is the items amount in the data structure.

 Originally Posted by archibalduk 

Yes, that's one of the options I'm looking at.

Currently the function is just iterating through a vector and performing a number of comparisons (e.g. comparing forename, surname and
DOB). However, it involves a couple of function calls with each iteration as I use a custom String class which allows me to control how the
string is formatted (e.g. ignore UTF characters if using csv, ignoring any accents if the user enables the Simple Match setting, etc). I'm
interested to see what impact it has on the speed if I construct a hashtable or vector with the formatted strings before making the comparison
rather than formatting the strings on the fly.
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I have found a lot of officials in the March 13/14 DB with invalid Years of Birth (e.g. 3514 and -21008). The Updater will correct these
when you load/save the DB. However, with what Year of Birth would you like me to set such Officials? Perhaps just set them to zero?

The same rule will apply to Players and Non-Players. So if a player has a Year of Birth set to something less than zero then the Updater
will correct it in the same manner.

EDIT: A second question I have is about the Year of Birth setting where the player/non-player/official has a Date of Birth set. In such
cases, is it ok to set the person's Year of Birth to the same value as the year of their Date of Birth? It seems people in the DB have
their Year of Birth set to zero if they have a Date of Birth set. I was wondering whether there is any reason for this or whether it's just
simply nobody bothers with the Year of Birth if the Date of Birth has been set seeing as presumably the game ignores the Year of Birth
in such circumstances.

Last edited by archibalduk; 12-08-14 at 04:50 PM.
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I've made a start on this today. So far it'll show a table like this (this shows the Acceleration attribute for the Belgian Premier League):

Ignoring the unfinished UI, is this generally what you had in mind? Do the table headings make sense? Here's what they mean:

- Value = Attribute rating value
- Count = Number of players in the selected league whose attribute is set to that value
- Less Than Value = number of players in the selected league who have a rating lower than the Value
- Great Than Value = number of players in the selected league who have a rating greater than the Value

^ The three Percentage columns are simply expressions of the above as a percentage.

Presently it only shows the totals relative to the players in the same league. I will be adding a separate table to show the comparison
against the rest of the DB. However, the percentage values will be really small (because we're comparing the number of e.g. Belgian
Premier League players with the whole DB).

I will also add a bar graph as well.

 Originally Posted by Dermotron 

That would be fantastically handy. Totals and percentages would be great. Total/% Vs. Whole DB and Total/% Vs. Eligible Players (players with
attribute other than 0)

Trying to manually calculate it in excel produces huge files that become unusable after awhile.
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Awesome archie 

An amazing analysis tool
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where are those 3514 and -21008?

i think the YoB just works when there is no DoB, otherwise is useless

Last edited by milo; 14-08-14 at 02:03 PM.

 Originally Posted by archibalduk 

I have found a lot of officials in the March 13/14 DB with invalid Years of Birth (e.g. 3514 and -21008). The Updater will correct these when you
load/save the DB. However, with what Year of Birth would you like me to set such Officials? Perhaps just set them to zero?

 Originally Posted by archibalduk 

EDIT: A second question I have is about the Year of Birth setting where the player/non-player/official has a Date of Birth set. In such cases, is it
ok to set the person's Year of Birth to the same value as the year of their Date of Birth? It seems people in the DB have their Year of Birth set to
zero if they have a Date of Birth set. I was wondering whether there is any reason for this or whether it's just simply nobody bothers with the
Year of Birth if the Date of Birth has been set seeing as presumably the game ignores the Year of Birth in such circumstances.
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Many thanks!

Here are some examples:

Janez Babnik -21008
César Pastro -21008
Pasquale Cangiano -17747
Zoran Arsic -4083
Miran Bukovac 3514
Lencie Fred 3514

The above examples don't seem to have any DoB set either. 2,386 of the 3,749 officials seem to have a YoB like this. Some of them
have a DoB set and so I guess it's not a problem for them. However, it looks like 1,420 of them don't have a DoB either.

AFAIK I haven't previously scrambled the DB with the Updater and so the above should be easily found in the March DB using the
Editor.
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where are those 3514 and -21008?
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they are in the editor too in fact, don't know why, don't know how it happened, it must be a bug.

if you can fix it set them to 0 
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Thanks! I've set it to zero.

I've finished re-writing the algorithm which looks-up and matches the data. As mentioned above, it now uses a hashtable rather than a
vector (which is what the EHM Updater uses). I've also made some other improvements to cut down a little on the data crunching. The
improvement in speed is remarkable. I'm seeing a 93% speed improvement over the EHM Updater's algorithm.

The test data I've been using is a spreadsheet of 300 players; 100 of which have the first 100 player IDs in the DB, another 100 have
the middle 100 IDs and the final 100 have the last 100 IDs in the DB. When importing the spreadsheet into the DB via the Updater, I
was getting speeds of approx 6.62 seconds to apply the changes with the old algorithm. With the new algorithm, it is importing at 0.47
seconds. That's a far bigger improvement that I was expecting or hoping for (I would have been happy with a 10% increase!).

The tests were done using an XML spreadsheet. This format is a little larger in file size and so the speeds are a little slower than using
CSV. I have since tested a CSV spreadsheet which updates every single player and staff attribute for every player in the March DB (all
82,665 of them). The time it takes to process this is 1.77 seconds. I was expecting a few of minutes at the very least (under the old
algorithm it would have taken around 25 minutes).

There are a couple of caveats:
- The timings don't yet take into account the time it takes to load the file into the memory before applying the update. In the case of
the CSV file, it took about 1 or 2 seconds. So you're looking at a total time of around 3 - 4 seconds to update all 82,665 records.
- If there are any erroneous entries in the spreadsheet (e.g. the player doesn't exist in the DB or you made a typo with the name or
DOB) then it'll take some time to write the errors to a spreadsheet. E.g. if every entry in my test spreadsheet containing 82,665 entries
was erroneous then I think it'd take roughly 6 - 10 seconds to write the spreadsheet detailing all of the errors.
- XML files are slower and I haven't tried a 82,665 entry XML spreadsheet yet. For such large volumes of data, I'd go with CSV.

There's still some work I need to complete before I can release the latest version, but things are going really well.

 Originally Posted by archibalduk 

Looks like the hashtable could be quicker in this instance. I've been testing using some test data and have found that a hashtable may be 0.015
secs per lookup faster than a vector. That's quite a lot of time if you're looking to update 70,000 records (i.e. importing attributes for every
player from one DB to another). I expect the actual speed will be different once I've implemented this into my application (because my test was
done in a separate test application), but it certainly looks like it could provide a speed improvement.

I'll keep on testing...
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I'm hoping to be able to upload a new version of the Updater later today. Before I do so, I'm going to post a couple of short tutorials
on how to use some of the new features. Here's the first one:

Importing Data Using the Updater Spreadsheets
This is essentially why I created the EHM 2007 Updater in the first place. The idea being that several people can work on the same
database at the same time. Each researcher can list their changes in the Updater Spreadsheets and then send them to the Head
Researcher. The Head Researcher can then import all of the Updater Spreadsheets into the master database using the Updater's Import
function.

The process can be broken down into 4 steps:

1. Create the spreadsheet templates;
2. List your changes in the relevant spreadsheets;
3. Import your spreadsheets;
4. Address any import errors.

1. Creating the Spreadsheet Templates

Before being able to list your changes, you will first need the spreadsheet templates.

You can either use CSV or XML format spreadsheets. If you are making a very large number of changes then you may be better off
using CSV because it is faster to import into the Updater. Otherwise, it doesn't really matter which format you use (although I know
some users can have trouble loading XML files in OpenOffice and older versions of LibreOffice).

Load the Updater and click on the Settings tab (there is NO need to load a DB into the Updater beforehand). You will see a group of
settings entitled "Defaul Export File Format". Select either CSV or XML (the HTML and TBL Forum Tables options are no use for the
purposes of creating the templates - they're more for exporting data).

Once you have chosen your spreadsheet format, click on the Spreadsheet menu and then click on Create Spreadsheet Templates.
Select a folder to save the templates to and then click on the Select Folder button to save the templates. Note that that the Updater
will overwrite any existing files with the same name as the templates. Hence I recommend saving the templates to an empty folder.

At present, the Updater will create three template spreadsheets:

1) official_update - This is used for editing officials' attributes
2) nonplayer_update - This is used for editing non-player attributes (you can also edit Staff Traits for non-players in this spreadsheet)
3) player_update - This is used for editing player attributes (you can also edit Staff Traits for players in this spreadsheet)

If you are using XML format and will be editing the spreadsheets using Excel then you may rename the spreadsheets' filenames to
whatever you want. If you are using CSV or OpenOffice/LibreOffice then you must keep the filenames the same. XML files can be
renamed because I have embedded a tag within the XML files which identifies what type of template they are (so the Updater can
detect the template type when importing the data). However, it seems OpenOffice/LibreOffice removes the tag when editing the
spreadsheet and so this is why you can only rename XML files that are edited with Excel.
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2. Listing Your Changes in the Updater Spreadsheets

For the purposes of this tutorial, I will use the player_update spreadsheet.

You will see in the player_update spreadsheet that the first six columns are entitled First Name, Second Name, Common Name , DOB
(dd), DOB (mm) and DOB (yyyy). The Updater will use the data you enter in these columns to match your players with those in the
database. Thus, for every player you want to edit, you must enter the following:

1) Either their full name OR Common Name (you do not need to enter both); and
2) Their date of birth.

Here are some examples:

The Updater is case insensitive. This means that it does not matter whether you enter players' names using uppercase or lowercase
letters. As can be seen in the screenshot above, you can use any combination you wish. However, you must use the corrected
accented letters if the player's name has any such accented letters (note that you can disable accented letters by using the Simple
Text setting - I'll explain this shortly in my tutorial on the Settings Screen).

Some players in the database do not have a Date of Birth set. Instead they just have a Year of Birth set. In such cases, you can leave
the Date of Birth columns blank. If you're ever in doubt about what DOB to enter, you can use the Updater to export a spreadsheet of
Staff or Officials and then see what DOB is listed there.

Once you have entered the names and DOBs for the players you want to edit, you can now list your changes. Simply complete the
relevant columns for the attributes you want to edit. If you want to change a player's Squad Number to "30" then just enter the
number 30 under the Squad # column for that player. You can leave as many columns blank as you like - the Updater will ignore any
blank columns and will only update the attributes you enter for each player.

You will see that near the beginning of the spreadsheet there is a set of New Date of Birth columns. You can use these columns to edit
the player's DOB. For example, if you want to change the player's month of birth to May then enter the number 5 in the MM column. If
you don't want to edit that player's day or year of birth (i.e. you just want to edit the month), you can leave these blank. If you want
to set the player's DOB to 1/2/1900 and instead use a Year of Birth, then enter 0 in the DD and MM columns and your chosen year in
the YY column. Here is an example:

In the screenshot above, the Updater will make the following changes to the players' DOBs:



In the screenshot above, the Updater will make the following changes to the players' DOBs:

1) Wayne Rooney's month of birth will be changed to April. So his new DOB will be 24-04-1973
2) Ryan Giggs' DOB will be reset to 01-02-1900 and his Year of Birth will be 1950.

Note that the Updater will ignore any DOBs you enter with a year between 1 - 1899. This is on the assumption that any such years are
a typing mistake and should not be imported.

Once you have made all of the desired changes using the various Updater Spreadsheets, you are now ready to import that changes
into the database.

Just one final note about the nonplayer_update spreadsheet: You will find a column in the spreadsheet entitled "Preferred Formation".
As the name suggests, you can edit the non-player's Preferred Formation using this column. If you want to change it to "none" then
enter the word _none in the column. If you want to change to a particular formation, enter 4-4-2 or 4 4 2 or 442 (or whatever the
desired formation is) into the column. If you export a Non-Player Attributes spreadsheet from the DB using the Updater you'll get an
idea of the various formations available (or you can look at the relevant drop-down menu in the Official CM Editor).

3. Importing/Applying Your Changes to the Database

Load your chosen database in the Updater. Then click on the Import button (you'll see this button towards the bottom of the Home
Screen (click on the "Home" tab).

When you click on the Import button you will be prompted to select the Updater Spreadsheet containing all of your changes. Select
your file and click on Open.

The Updater will now import your changes. Once it has finished importing, you will be presented with a message detailing the number of
records that were successfully imported and, if any errors were encountered, the number of erroneous records. See the section below
on how to address errors.

If you are happy, you can now save your database.

4. Addressing any Import Errors

If any errors were encountered during the import process, the Updater will create an _errors spreadsheet in the same folder as the
Updater Spreadsheet you imported. The Errors Spreadsheet will have the same filename as your Updater Spreadsheet but with "_errors"
appended to the filename.

If you open the Errors Spreadsheet, it'll look a bit like this:

The spreadsheet lists every record where an error was encountered. In the far left column(s) you will see the source of the error for
each record. At the time of writing (version 0.0.3) there is only one error (but there will be more once I add more advanced editing).
The cause of the error will be that no matching player/non-player/official can be found in the database. This means that the Updater
could not find a matching person with the specified name and DOB in the database.

Common causes of this error are:

1) You have mispellt the person's name or you have missed an accented letter.
2) You have entered an incorrect date of birth. Remember that if the player only has a Year of Birth and no Date of Birth set then you
can leave the DOB columns blank for that player.
3) You are trying to edit player attributes for a non-player or vice versa. E.g. if you are using the player-update spreadsheet and you
enter a non-player's details, the Updater will treat this as No Match because there is no matching player.

You can either correct the mistakes in your original Updater Spreadsheet or you can copy and paste the data from the Errors
Spreadsheet into another Updater Spreadsheet and correct the errors that way.

20-08-14, 12:00 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

The Settings Screen
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I thought it would be useful to explain how the Updater's settings work as it's probably not obvious from the screen (I hope to be able
to add a Help section to the Updater in the future which will explain things like this).

You can hover your mouse over any of the radio buttons on the Settings screen to get a brief explanation as to what that setting
does.

The status bar at the bottom of the window shows what settings you have currently selected.

Here is a run-down of each setting:

Default File Format

There are currently four formats supported. CSV and XML are the recommended file formats.

The HTML and TBL Forum formats are for planned features not yet implemented (e.g. team reports for online leagues so that they can
be uploaded straight to the online league's website). The TBL Forum Format is designed with some EHM tools in mind and doesn't yet
work (my forum has some Table BBCode which allows tables to be posted in forum posts). As far as I can see, the CM01/02 Forum does
not support Table code - but if it does, let me know and I'll add this as a fifth file format.

This has two main functions:

1) It sets the format of spreadsheet when using the Create Spreadsheet Templates function.

2) It sets the default format when exporting data. This is simply to make things a little more convenient when exporting data. Note
that if you want to export to a different format from your chosen default format then you can just use the drop-down menu on the
Save Spreadsheet dialog window like so:

Name Lengths



Name Lengths

Allows you to export team names using their long name or short name. Once contract editing and staff career history importing is up
and running, it'll determine whether you need to enter the long or short team in the the relevant Updater Spreadsheets.

Date of Birth Matching

As mentioned in my previous tutorial, you must enter the player/non-player/official's full date of birth in the Updater Spreadsheet.
However, you can change this by selecting the Year of Birth Only setting.

If you select the Year of Birth Only setting then you need only enter the Year of Birth in the Updater spreadsheet. If the player has a
full DOB in the database, then just enter the year from his DOB. If he has no full DOB and only has a Year of Birth in the database,
enter his Year of Birth.

Here are some examples:

Text Matching

This controls how the Updater matches text, such as Full Names and Common Names in Updater Spreadsheets. If you select Simple
Text then there is no need to use accented letters in player names. E.g. "Iñaki Morán" can be entered as "Inaki Moran".

I think using the title "Simple Text" is a bit misleading. I'll probably change the name of this setting to "Ignore Accents" in the next
version so that it is a little clearer.

It's worth keeping in mind that if you enable the Year of Birth Only and Simple Text settings, this may make it easier for false-positives
to arise. E.g. let's say you have two different players in the database like this:

1) David Morales born on 15/04/1983
2) Dávid Moralés born on 01/10/1983

If you enable both of the Year of Birth Only and Simple Text settings, the Updater will treat both of the abovenamed players the same
(because it'll ignore all of the accents and it'll only take into account the Year of Birth).
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The Attribute Stats Screen
As discussed earlier in this thread, the Attribute Stats Screen consists of a table and bar chart showing the distribution of attribute
ratings on a per league basis.

When I started writing this function, I was concerned that generating the stats would be quite a CPU-intensive task. Therefore I
decided that the Updater wouldn't generate the stats upon loading the DB. Instead, the user must generate the stats by clicking on
the Refresh Data button located at the bottom of the Screen. However, it turns out that generating the stats is not very challenging
for the CPU at all (it seems to take about 1/10th of a second). Thus I plan to remove the Refresh Data button and instead the stats
will be updated when you load the DB or import new data.

In the meantime, you must click on the Refresh Data button to generate the stats. You can then select the league and attributes
using the button and drop-down menu located at the bottom of the screen. Note that you do NOT need to click on the Refresh Data
button more than once.

You can click on the Table and Bar Chart tabs to switch between the two (the Bar Chart tab button is located below the Table).
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 Originally Posted by archibalduk 

Just one final note about the nonplayer_update spreadsheet: You will find a column in the spreadsheet entitled "Preferred Formation". As the
name suggests, you can edit the non-player's Preferred Formation using this column. If you want to change it to "none" then enter the word
_none in the column. If you want to change to a particular formation, enter 4-4-2 or 4 4 2 or 442 (or whatever the desired formation is) into
the column. If you export a Non-Player Attributes spreadsheet from the DB using the Updater you'll get an idea of the various formations
available (or you can look at the relevant drop-down menu in the Official CM Editor).
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The formations are hardcoded into the exe; so it would need some exe editing of some description.

All the database stores is the ID number for the chosen preferred formation. E.g. 0 = no preferred formation, 1 = 5-3-2 sweeper, 2 = 5-
3-2, etc. The Updater can insert any ID number up to 128 for that particular setting, but the game will only pick up ID numbers from 0
to 9.
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Seeing as I have the non-player, player and official attribute editing functions and the attribute stats up and running (and I'll have little
time over the next few weeks to do much more work), now seems like a good time to release the next version. So here is version
0.0.3 - http://1drv.ms/1pL6Ren 

IMPORTANT!
Owing to time restraints, I haven't been able to test as extensively as I'd like to (as is always the case!). Keep this in mind when using
the Updater. Try editing just a little bit of data and then test your DB in game to make sure there are no crashes and the attributes
appear as you'd expected. I don't envisage there being any problems in terms of stability because it's just simple attribute editing - but
best to be cautious.

Minimum Requirements
If you haven't already installed the Microsoft Visual C++ 2010 Redistributable Package then you'll need to first download and install it:
http://www.microsoft.com/en-us/downl...s.aspx?id=5555

Installation/Upgrade
Simply extract the contents of the downloaded zip file into a folder of your choice. You'll see that the zip file consists of the exe and a
number of dll files (including a 'platforms' sub-folder which consists of 3 further dll files).

If you have a previous copy of the Updater on your computer, you can just overwrite the files with the latest version. You don't have
to delete your existing settings.cfg file, but I recommend it this time around because I've changed the settings system substantially
since v0.0.2.

If you're going to edit and save a database located in C:/Program Files/../ then you must use 'Run as Admin' to load the Updater -
otherwise it won't be able to save your database properly (as with any other editor, if you don't use Run as Admin for a database in
Program Files, you'll end up with a shadow copy in your /Users/Roaming/ folder which is a real pain). Also, you must always use 'Run as
Admin' if you install the Updater to C:/Program Files/../ (otherwise it won't be able to save your settings to its config file).

Changelist
There are a hell of a lot of changes following the previous version. Most of the changes are behind the scenes things and so I won't
bore you with the details. Here's a list of the main changes since the previous version:

* Fixed the CA Range bug which was causing the ranges to be displayed incorrectly;
* Added Attribute Stats screen with a table and bar chart;
* Added non-player attribute updating via the nonplayer_update spreadsheet;
* Added player attribute updating via the player_update spreadsheet;
* Added official/referee attribute updating via the official_update spreadsheet;
* Added the option to export data to HTML;
* Improved Settings screen;
* Name and Players counters added to the name and nation dat files.

Known Issues
* The Erase Data function is still buggy. I've made a couple of changes, but this still needs more work. I'd advise not using this feature
for the time being.
* Non-Player Updater Spreadsheet: The Preferred Player Models settings do not work yet (the Updater will just ignore anything you put
in those columns). I need to put in some further work in order to get those parts working.
* Official Updater Spreadsheet: The Nationality and Birth City settings do not work yet (the Updater will just ignore anything you put in
those columns). I need to put in some further work in order to get those parts working.
* When importing a CSV/XML spreadsheet, a progress bar is not displayed until the spreadsheet has loaded into the
memory. Thus, when you load larger spreadsheets (e.g. 10mb+) there will be a slight pause when the Updater seems to be
doing nothing before a progress bar appears. Just be patient - a 15mb file takes about 2 or 3 seconds to load. I plan to add a
progress bar for the next version.

Planned Features for the Next Version
* Ability to export the Attribute Stats to a spreadsheet (hopefully including the bar charts);
* Make the Attribute Stats bar charts stretch to the full height of the window (it seems Qt has difficulties getting the actual visible
window height which is why it doesn't stretch right now);
* Hopefully fix the Erase Data Function;
* Get the remaining parts of the Non-Player and Official Updater Spreadsheets working;
* Add "U-21" to international U-21 team names so they can be distinguished from senior international teams;
* Add a progress bar when loading the Updater Spreadsheets;
* There is a very slightly different spacing between text on the Attribute Stats screen. I'll fix this for the next version.
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just tested the importing tool and it works! (i was sure it did) 

and also the charts are great 

one thing, when importing a player it creates his YOB in the db, don't think it can cause any issues but can this be removed?

also, in the CA ranges page swedish leagues have their generic name only (swedish second, swedish third), without the geographical
status, can you fix that?

about this, do you mean that if you enable the other 119 (128-9) id numbers in the exe you can choose among 129 different
formations to insert in the db?

 Originally Posted by archibalduk 

The formations are hardcoded into the exe; so it would need some exe editing of some description.

All the database stores is the ID number for the chosen preferred formation. E.g. 0 = no preferred formation, 1 = 5-3-2 sweeper, 2 = 5-3-2,
etc. The Updater can insert any ID number up to 128 for that particular setting, but the game will only pick up ID numbers from 0 to 9.
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 Originally Posted by milo 

just tested the importing tool and it works! (i was sure it did) 

and also the charts are great 

one thing, when importing a player it creates his YOB in the db, don't think it can cause any issues but can this be removed?

also, in the CA ranges page swedish leagues have their generic name only (swedish second, swedish third), without the geographical status,
can you fix that?

about this, do you mean that if you enable the other 119 (128-9) id numbers in the exe you can choose among 129 different formations
to insert in the db?
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can we insert players and staff to the certain club using updater?
can we insert new players or just update existing one?
i'm confused what actually import data means?
thanks

Last edited by djole2mcloud; 20-08-14 at 09:07 PM.
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Glad to hear that! I find it a bit nerve-wracking when releasing my editors because I have a fear it'll crash or won't work on other
people's systems.

If it doesn't cause any issues, I'd rather leave it in because it makes updating staff/officials a little bit easier. Is there any particular
reason you'd rather see this removed?

I'll need to check, but I'm guessing that'll also be an issue for the League List on the Attribute Stats Screen. I'll see what I can do. The
first thing that comes to mind is to add the three letter abbreviation of the nation to the beginning or end of each league name. 

Incidentally, I want the League List on the Attribute Stats Screen to eventually be sortable by ID, nation, reputation and alphabetically
(rather than being fixed in ID order right now).

Yes, that's right. I can input any number into that field of the DB. I'm doing this from memory, but I think the Preferred Formation field
is a signed char which means a range from minus 127 to positive 128 (i.e. -127 to 128). Technically that means 256 possible values.
Currently 0 is No Preferred Formation and 1 - 9 are the various formations. Hence the Updater will only allow those 10 settings right
now. But if more formations were added to the exe then I can implement this into the Updater. I don't know how the Official Editor
would handle any additional settings however - because the Editor would be fixed to handle those 10 settings.

I have absolutely no idea how feasible it is to add new formations to the exe. I'd say it sounds impossible, but seeing as Tapani is a bit
of magician when it comes to these things, who knows!!

 Originally Posted by milo 

just tested the importing tool and it works! (i was sure it did) 

and also the charts are great 

 Originally Posted by milo 

one thing, when importing a player it creates his YOB in the db, don't think it can cause any issues but can this be removed?

 Originally Posted by milo 

also, in the CA ranges page swedish leagues have their generic name only (swedish second, swedish third), without the geographical status,
can you fix that?

 Originally Posted by milo 

about this, do you mean that if you enable the other 119 (128-9) id numbers in the exe you can choose among 129 different formations to
insert in the db?
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No it can't create or move players/non-players between teams yet. It is something I have planned, though. I added attribute editing
first because it is the easiest to implement and the work involved forms the basis of more complex functions, such as transferring and
creating players/non-players.

"Import data" means to import the data from the spreadsheet into the database. At the moment the only importing that can be done is
to import changes from the three attribute spreadsheets into the database. Another way to think of it is that the Updater applies the
changes you list in the spreadsheets.
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can we insert players and staff to the certain club using updater?
can we insert new players or just update existing one?
i'm confused what actually import data means?
thanks
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ok,clear now...
it looks really beautiful...
looking forward for the new options...
thanks
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« New guy, new league | Skills to Learn for Patching/RE? »

i will test it better later and will report any issue 

nevermind, it's fine, i also realized that it does creates YOB's in db but just when you select a player in the editor it disappears

one more desire, i wonder if you can add a phantom chart behind those you crated for attributes that represents the average value of
the whole db.
i mean, if i show the english premier finishing chart where there are 10 players out of 100 with finishing 20 (10% of the total), can you
add another chart behind that shows the number of players with finishing 20 in the entire db?
so that if they are 1.000 out of 100.000 they are just the 1% so the chart bar is 1/10 of the english premier one

this would be wonderful, i'm going to ask the master 

 Originally Posted by archibalduk 

Glad to hear that! I find it a bit nerve-wracking when releasing my editors because I have a fear it'll crash or won't work on other people's
systems.

 Originally Posted by archibalduk 

If it doesn't cause any issues, I'd rather leave it in because it makes updating staff/officials a little bit easier. Is there any particular reason
you'd rather see this removed?

 Originally Posted by archibalduk 

I'll need to check, but I'm guessing that'll also be an issue for the League List on the Attribute Stats Screen. I'll see what I can do. The first
thing that comes to mind is to add the three letter abbreviation of the nation to the beginning or end of each league name. 

Incidentally, I want the League List on the Attribute Stats Screen to eventually be sortable by ID, nation, reputation and alphabetically (rather
than being fixed in ID order right now).

 Originally Posted by archibalduk 

Yes, that's right. I can input any number into that field of the DB. I'm doing this from memory, but I think the Preferred Formation field is a
signed char which means a range from minus 127 to positive 128 (i.e. -127 to 128). Technically that means 256 possible values. Currently 0 is
No Preferred Formation and 1 - 9 are the various formations. Hence the Updater will only allow those 10 settings right now. But if more
formations were added to the exe then I can implement this into the Updater. I don't know how the Official Editor would handle any additional
settings however - because the Editor would be fixed to handle those 10 settings.

I have absolutely no idea how feasible it is to add new formations to the exe. I'd say it sounds impossible, but seeing as Tapani is a bit of
magician when it comes to these things, who knows!!
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Yes, that shouldn't be too hard to add.  I'll make it optional so you can hide/show the phantom chart.

I also think the chart and table should be broken down by position. If you look at the Handling graph you'll see it's really misleading
because it includes the Handling rating for outfield players. I think breaking it down into G/D/M/F is probably too far, but maybe if we
just split it between goalies and outfield players.
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 Originally Posted by milo 

one more desire, i wonder if you can add a phantom chart behind those you crated for attributes that represents the average value of the
whole db.
i mean, if i show the english premier finishing chart where there are 10 players out of 100 with finishing 20 (10% of the total), can you add
another chart behind that shows the number of players with finishing 20 in the entire db?
so that if they are 1.000 out of 100.000 they are just the 1% so the chart bar is 1/10 of the english premier one
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I take it this doesn't work on Vista 32 bit????
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It should do. I tested it in my spare Windows XP installation (which I have installed via
Virtual Box) and it seemed to run fine.
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 Originally Posted by Steel Force 

I take it this doesn't work on Vista 32 bit????
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10

I have downloaded it, opened it (run it) it came up with the EHM 2007 Updater box and then it shows me a screen with only the
following options in use: File, Spreedsheet, Settings, Help. All other options are not clickable. Clearly I've done something wrong or
missed something off. 

Thanks
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The other functions are unavailable because you have not loaded a DB into the Updater. Click on File -> Open Database, navigate to
your Database folder and click on the Select Folder button. The Updater will load the DB and you'll see all of the other buttons and
tabs will now be enabled.
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Will give it a go when I'm not to busy :-)
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I just tried to load the original .60 database and each time it crashed.. is this written solely for the purpose of opening databases that
use the .68 patch?
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Yes, I'm afraid so.

Out of curiosity, is there a reason you're using .60 rather than 0.68? The reason I ask is that if there is a real reason why .60 is a
necessary version then I'll look into making the Updater compatible with .60. The reason for not having done this so far is simply
because of the time it would take to implement (time I've been spending getting the other features running).

#131
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 Originally Posted by Jesus 

I just tried to load the original .60 database and each time it crashed.. is this written solely for the purpose of opening databases that use the
.68 patch?

26-08-14, 08:37 PM

Join Date:
Posts:

04-03-12
3,459

My main ambition was to move the current update from the .68 patch to the .60 patch due to some very irritating bugs that occur with
the .68 bug (getting a job in another country for example). However, you've yet to implement the ability to inject players to teams so
my progress was quickly scuppered. As a result I'm waiting for the next update to this wonderful tool which will hopefully allow people
to inject players to teams.

I would like it to be compatible with the .60 patch as well as the .65 patch but if it's something that isn't a priority for you then that is
fine. There are a number of members here who would love to see the update on older patches mainly because of the irritating bugs
that we have come across.

As a side note, I really like the interface you've made, it's clean and easy to understand and I'm sure the update team will be forever in
your debt. It is such a powerful tool.

#132

First Team Player
Jesus 

 Originally Posted by archibalduk 

Yes, I'm afraid so.

Out of curiosity, is there a reason you're using .60 rather than 0.68? The reason I ask is that if there is a real reason why .60 is a necessary
version then I'll look into making the Updater compatible with .60. The reason for not having done this so far is simply because of the time it
would take to implement (time I've been spending getting the other features running).
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250

Thank you very much indeed. 

Once I've got my priority functions up and running (contract/staff data editing, staff history injection and staff injection), I'll see what
I can do about being compatible with older DB versions. Looks like there's a useful thread here which might help me figure out the
differences between the two DB formats: http://www.champman0102.co.uk/showthread.php?t=2319
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archibalduk 

02-10-14, 07:50 PM

Join Date:
Posts:

02-03-12
3,608

i have found some more issues in the club file.

- clubs that play in "a premier division" are listed in "premier division", this means they are in the same competition as english, dutch,
russian, etc. premier league clubs.

- the cash column only shows until 999.999, beyond that an exponent is showed.

- also, some of them are bugged, for example everton have 1.181.250.000.000 £ while they have 11.812.500 £ in the editor
(1/100.000)
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Location:
Posts:

the English Channel
250

The competition names appearing as "Premier Division", etc is most likely because you have enabled the "Use Short Names" setting on
the Settings screen. Change it to "Long Names" and this should fix your problem. If it doesn't then please let me know.

I'll check out the cash column issue once I get back to work on the Updater (I have been taking some time off because it's crunch time
with the EHM and FHM hockey roster work). The exponent issue is likely a number formatting issue in Excel (I noticed the same issue
with the EHM Updater last weekend). I'll see if there's a way around it and also what is going on with the bugged figures.

Reserve Team Player

02-11-14, 06:02 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Just checking in to say that I'm still working on the next version of the Updater. Unfortunately progress has slowed since I returned to
work from annual leave and particularly since I temporarily changed offices in September (longer commute meaning I lose an hour of my
evening compared to before - but it's only until mid-March next year). Also it has been the busy time of the year for hockey roster
updating. Anyhow, I have still been chipping away and hopefully I'll have a new update released in late November / early December.

Most of the work has been behind the scenes stuff that makes adding new functions possible, so there's nothing particularly exciting to
report. I've spent a lot of time on the UI; particularly building my own stylesheet and menu system. I'm now finishing off the overall
look of the UI. It's nothing exciting, but it'll make navigating the application a little easier and generally things will be less cluttered.

As for the updater files:
* Birthplace and nationality are now editable for officials;
* Preferred player models for non-players are now editable and there is proper error-checking for preferred formations;
* I will soon be adding player career history injection.

I have also made some improvements with the attribute stats bar chart and table:
* The bar chart now fills the window. I am working on it automatically resizing/stretching when you resize the window (currently it only
resizes each time you click on the Refresh Data button);
* I have started adding sub-category functionality to the chart and table - so that the stats are broken down by position (Goalie, Def,
Mid, Att, Outfield and Totals).
* Once I've completed the above two items, I'll be adding the Total bar chart and table so the league attribute stats can be compared
against the overall DB totals (again, with the option to break the stats down by position).

Last edited by archibalduk; 02-11-14 at 06:08 PM.
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good man 
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Hi archibalduk & JohnLocke! 
I want to reminder something about national languages.
In the official editor with ODB Mongolia's first languages is ''Not Set''. But in the game with usage ODB or with usage v.9.68 original
patch-database a Mongolese player is fluent in ''Mongol Language''. In the game with every year updated databases ''Mongol Language''
is lost. 
Same situation in Ukraine too. In the official editor with ODB Ukraine's first language is ''Not Set'', second language is ''Russian'', but in
the game with usage ODB or with usage original v.9.68 patch-database an Ukrainian player is fluent in ''Ukrainian and Russian''. İn
updated databes ''Ukrainian language is lost, they know only Russian'.
Similar situation in South Africa too. In the official editor with ODB South Africa's first language is ''English'', second '' Not Set'', third
''Afrikaans'', but in the game with usage ODB or with usage v.9.68 original patch-database most of south african players fluent in
''English'' and ''Zulu'' and their basic languages are Afrikaans.
In the official editor with ODB Bosnia-Herzegovina's first languague ''Not Set'' in the game turned into ''Bosnian'' which is Croatia's third,
Yugoslavia's second in the game.
Any ideas?
Or can you add Bosnian, Mongol, Ukrainian and Zulu languages to the drop list in your updaters-editors?

Last edited by scemoka; 03-11-14 at 11:51 AM.
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Excellent.
please add option for adding data to DB from .csv or similar...will make life easier :-)
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03-11-14, 04:04 PM

Join Date:
Posts:

02-03-12
3,608

welcome back archibald 

could you try to improve your tool to let the update them work less and, if possible, even better?
if so, can we tell you what we really need and you tell us your opinion about it?

#140

Director
milo 

 Originally Posted by archibalduk 

Just checking in to say that I'm still working on the next version of the Updater. Unfortunately progress has slowed since I returned to work
from annual leave and particularly since I temporarily changed offices in September (longer commute meaning I lose an hour of my evening
compared to before - but it's only until mid-March next year). Also it has been the busy time of the year for hockey roster updating. Anyhow, I
have still been chipping away and hopefully I'll have a new update released in late November / early December.

Most of the work has been behind the scenes stuff that makes adding new functions possible, so there's nothing particularly exciting to report.
I've spent a lot of time on the UI; particularly building my own stylesheet and menu system. I'm now finishing off the overall look of the UI. It's
nothing exciting, but it'll make navigating the application a little easier and generally things will be less cluttered.

As for the updater files:
* Birthplace and nationality are now editable for officials;
* Preferred player models for non-players are now editable and there is proper error-checking for preferred formations;
* I will soon be adding player career history injection.

I have also made some improvements with the attribute stats bar chart and table:
* The bar chart now fills the window. I am working on it automatically resizing/stretching when you resize the window (currently it only resizes
each time you click on the Refresh Data button);
* I have started adding sub-category functionality to the chart and table - so that the stats are broken down by position (Goalie, Def, Mid, Att,
Outfield and Totals).
* Once I've completed the above two items, I'll be adding the Total bar chart and table so the league attribute stats can be compared against
the overall DB totals (again, with the option to break the stats down by position).

03-11-14, 10:41 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Thanks for the welcome back!  Although I never really left - I have regularly checked in but have had nothing to report and nobody
has posted much in this thread.

Yes, please do tell me what the update team really need. Helping the update team is exactly what I want to do with this tool.

That's the plan.  First will be player career history injection and then I'll be adding player, non-player and official injection (via csv
and xml).

I think somebody like JL is the man to respond to this. I'm afraid I don't have much knowledge of the language aspects and it's not
something I currently plan to develop within the Updater. JL has a plethora of tools so he may be able to help.

#141

Reserve Team Player
archibalduk 

 Originally Posted by milo 

welcome back archibald 

could you try to improve your tool to let the update them work less and, if possible, even better?
if so, can we tell you what we really need and you tell us your opinion about it?

 Originally Posted by djole2mcloud 

Excellent.
please add option for adding data to DB from .csv or similar...will make life easier :-)

 Originally Posted by scemoka 

Any ideas?
Or can you add Bosnian, Mongol, Ukrainian and Zulu languages to the drop list in your updaters-editors?

04-11-14, 03:23 PM

Join Date:
Posts:

02-03-12
3,608

well... maybe i'm asking for the moon... but it would be great to have a tool that converts a text (access, excel, etc.) to the .dat file
the game needs, is that possible?
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This is basically what the Updater does right now. It takes a text file (Excel - csv or xml) containing player attributes, non-player
attributes and official attributes and imports them into the DB. Next I will be adding the ability to import new player career history
entries from Excel into the DB (and after this, I will be doing the same with creating new players/non-players, editing contracts, etc of
existing players and importing new officials). Was there something else you had in mind?

==================

By way of a further update, the Attributes Chart now allows us to break-down the chart by position (see screenshots below). My next
task is to get the Grand Total graph overlay to appear.

 Originally Posted by milo 

well... maybe i'm asking for the moon... but it would be great to have a tool that converts a text (access, excel, etc.) to the .dat file the game
needs, is that possible?

https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=203242#post203242


Last edited by archibalduk; 04-11-14 at 10:34 PM.
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Just another quick update: I've got the overlay up and running now. The overlay shows the stats for the entire database for the
chosen position and attribute so that you can compare it to your selected league. I just need to make it so that you can turn the
overlay on and off and to finalise the colour scheme of it.

#144

Reserve Team Player
archibalduk 

04-11-14, 11:56 PM

Join Date:
Location:

Posts:

02-03-12
WATING FOR 10 IN

A ROW
6,197

looks really, really good archie 

if we get it working with our DB it will be sensational for us i think 
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yes, but you need to manually add names and dobs of the players you want to edit, this makes the editing very very slow.

in my ideal world, you should be able to generate the text file of the db (what your exporting tool already does) and simply edit it right
away, then re-upload your sheet into the db.

if this is possible the 1st step for the happiness of the updater is made 

 Originally Posted by archibalduk 

This is basically what the Updater does right now. It takes a text file (Excel - csv or xml) containing player attributes, non-player attributes and
official attributes and imports them into the DB. Next I will be adding the ability to import new player career history entries from Excel into the
DB (and after this, I will be doing the same with creating new players/non-players, editing contracts, etc of existing players and importing new
officials). Was there something else you had in mind?

05-11-14, 05:57 PM

Join Date:
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Posts:

04-03-12

Serbia,Belgrade,Zemun
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... now updater exports data to .csv or .html...archie,after u add option for inserting staff and players,is it possible exported data (from

.csv or .html)to be instantly inserted in different DB?let's say i export everything i'v alredy updated in march DB,and now i want only to
transferit to october DB?that could save a tons of working hours while patching leagues...
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 Originally Posted by milo 

yes, but you need to manually add names and dobs of the players you want to edit, this makes the editing very very slow.

in my ideal world, you should be able to generate the text file of the db (what your exporting tool already does) and simply edit it right away,
then re-upload your sheet into the db.

if this is possible the 1st step for the happiness of the updater is made 
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This is already possible. You can export the player/non-player/offical attributes into a spreadsheet, edit the spreadsheet and reimport
them (either by deleting the extraneous columns or by copying and pasting the data into the appropriate template spreadsheet).

However, this is not the best way to do things because it means that you will overwrite any changes that other users make (assuming
other users are working on the attributes at the same time). It is much better to just list the changes you want to make (i.e. don't list
the attributes you don't want to alter). The best way to do this is to export a staff/official list, find the players/non-players/officials
you want to edit and copy and paste them into the template and then make your changes. It is very simple to use the
Excel/OpenOffice filters to create a list of all players/non-players from a particular league - and you can put these names and DOBs in
your template.

Yes it is - Export the player/non-player attributes using the Updater and paste the exported data into the appropriate template
spreadsheet.

If you think you will want to copy your changes from one DB to another, the best thing to do is to use an Updater spreadsheet to
make all the changes you want. If you keep your spreadsheet up to date with all of your changes (i.e. rather than using the Pre-Game
Editor to make your changes) then you can import your spreadsheet into any DB you want.

The same can be done with updating player transactions once I get contract editing up and running. Then you can list all of the
transactions/contract updates, etc in one spreadsheet and import it into as many DBs as you want.

#148

Reserve Team Player
archibalduk 

 Originally Posted by milo 

yes, but you need to manually add names and dobs of the players you want to edit, this makes the editing very very slow.

in my ideal world, you should be able to generate the text file of the db (what your exporting tool already does) and simply edit it right away,
then re-upload your sheet into the db.

 Originally Posted by djole2mcloud 

is it possible exported data (from .csv or .html)to be instantly inserted in different DB?let's say i export everything i'v alredy updated in march
DB,and now i want only to transferit to october DB?that could save a tons of working hours while patching leagues...
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Would it make more sense to have the exported_xxxx.csv and xxx_update.csv map the same? I was just having a try of editing an
exported file but there are extra columns in player_update file. Unless of the course the exported file can be edited and reimported.

Champman0102.co.uk Facebook Page
13000 followers and rising

November 2020 Data Update Out Now

Captain
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Posts:
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3,608

i talked of the 1st step in my previous post, if you can do what i'm going to ask we are on the 2nd step 

since you said extraneous colums can generate errors of course, can you supply a ready-to-use sheet?
i mean an exporting option that allows you to create a sheet with everything that can be edited (about that category, i.e. players,
clubs, etc.) and without the extraneous columns?

also, i was wondering if you can make another option that lets you export only a part of the db, for example only the players based in
france, this way every updater exports his own nation and more people can update at the same time without possible issues of
overwriting (i know this can be manually made, extract the whole file, filter out what you don't need and work on the rest, but not all
the updaters ''like'' excel and the more you have to do the more you can get errors...)

#150

Director
milo 

 Originally Posted by archibalduk 

This is already possible. You can export the player/non-player/offical attributes into a spreadsheet, edit the spreadsheet and reimport them
(either by deleting the extraneous columns or by copying and pasting the data into the appropriate template spreadsheet).

However, this is not the best way to do things because it means that you will overwrite any changes that other users make (assuming other
users are working on the attributes at the same time). It is much better to just list the changes you want to make (i.e. don't list the attributes
you don't want to alter). The best way to do this is to export a staff/official list, find the players/non-players/officials you want to edit and copy
and paste them into the template and then make your changes. It is very simple to use the Excel/OpenOffice filters to create a list of all
players/non-players from a particular league - and you can put these names and DOBs in your template.
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There are a small number of columns you need to delete in order to make a file such as
exported_players into player_update. Off the top of my head, it's Year of Birth and the
Club and League columns. These columns are present so you can review whether any
players/non-players can have full DOBs added and also so you can filter player/non-
players from certain teams/leagues (useful if you just want to work on the attributes for
e.g. Barcelona or the whole of the Premier League).

However, I can add some export options so you can export the player, non-player and
official attributes into a file without these extraneous columns.

Yeah I can look into this for you. I think I would initially limit it to exporting player and
non-player attributes and perhaps also the staff list. I will probably look at this once I
have finished adding the various key updating functions (i.e. staff history and
player/non-player injection).
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 Originally Posted by milo 

since you said extraneous colums can generate errors of course, can you supply a ready-
to-use sheet?

 Originally Posted by Dermotron 

Would it make more sense to have the exported_xxxx.csv and xxx_update.csv map the
same? I was just having a try of editing an exported file but there are extra columns in
player_update file. Unless of the course the exported file can be edited and reimported.

 Originally Posted by milo 

also, i was wondering if you can make another option that lets you export only a part of
the db, for example only the players based in france, this way every updater exports his
own nation and more people can update at the same time without possible issues of
overwriting (i know this can be manually made, extract the whole file, filter out what you
don't need and work on the rest, but not all the updaters ''like'' excel and the more you
have to do the more you can get errors...)
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what about updating club info's from .csv(club name,attendances info,finances,stadium)?
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I'll put it on my to-do list, but it'll be after I've completed things like staff history injection and staff contract updating and injection.

 Originally Posted by djole2mcloud 

what about updating club info's from .csv(club name,attendances info,finances,stadium)?
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Excellent...
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right laddies,

i have downloaded it, 

open it up no probs,

loaded up my data folder no probs, can see the graphs etc for different attributes etc.

so how do i make a sheet so i can look at teams and then their players by CA?

also same for manager/coaches?

do i have to export these and then open them with WPS presentation [downloaded than and installed it as it was on here a page or so
back]

bare with me, it could be a long night 
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select ''export all'' on the bottom of the home tab and click ''export'', it will create a series of excel files 
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done
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it's exported a lot of XML? files,
they look like notepad files? is that right? [or more than likely have i fucked it up ]
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in the settings tab select csv files 
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i take it that is before i export them all mate?
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right all exported again,

csv this time 

- - - Updated - - -

now, best way to open these babies up?
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yes, export them again 
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they should be ready to be opened up by excel
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right, what next? i got here before and opened it but it was a mess 

do i need to change some settings here?
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no idea, is this what you get when you double click on the exported csv's?

try to separate by comma though
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You should be able to open the XML files in OpenOffice. However, I have heard that some people have had difficulties loading this file
type in OpenOffice (whereas LibreOffice is compatible with XML). If in doubt, make sure your copy of OpenOffice/LibreOffice is up to
date.

Here's a rough guide on how to look at the CAs of players in a chosen league (let's take the Premier League for our example). The
principle will apply the same regardless of which spreadsheet you're looking at. So hopefully this guide will show you how to look at the
managers' CAs (using exported_non-players-attributes.csv) as opposed to "exported_players-attributes.csv" which contains the player
attributes. I use LibreOffice rather than OpenOffice, so the screenshots will look slightly different to OpenOffice - but they should be
similar enough to help you. 

1. First we need to load the exported_players-attributes.csv file in OpenOffice/LibreOffice. On first opening the file, you'll be presented
with a Text Import window where you must select your delimiter. I can see from your screenshot in your previous post that your files
have a comma delimiter. Therefore you should tick the Comma box and untick all other boxes like this:
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Note: If you don't live in the UK or North America (or if you receive a csv from somebody outside of the UK / North America), you are
likely to have semicolon delimiters in the file. In which case you should select Semi-Colon rather than Comma.

2. The file will now load into OpenOffice/LibreOffice and everything should be presented in different cells (if it doesn't then re-open the
file as per step #1 above and select the opposite of what you selected last time - i.e. Comma or Semi-Colon).

3. We must next add some autofilters to the header row so that we can filter through the data. Some spreadsheets have two header
rows whereas others have one header row. In exported_players-attributes.csv you'll see there are two header rows. In which case,
click on the "2" in order to select the whole row (if there is only one header row then you'd click on the "1" instead):

4. Now that the header row is selected, click on the Data menu -> Filter -> Auto Filter. You will now see that there are drop-down
menus next to each cell in the header row. You can use these to filter out the various data. So to select the players in the English
Premier League, click on the drop-down arrow next to the Competition cell. Then un-tick the "All" button in order to de-select all of the
leagues:

Then scroll down through the list and tick the box next to the English Premier Division and click on OK:



Then scroll down through the list and tick the box next to the English Premier Division and click on OK:

5. You'll now see that the list is filtered to show just the EPL players. You can use the other drop-down menus to re-sort the data.
E.g. click on the drop-down menu next to the Club header cell and click on "Sort Ascending" to sort the players by Club (although I find
the sorting functions to be really slow in Open/LibreOffice).

Note: Before auto-filtering, you may also wish to freeze the header row so that it doesn't disappear when you scroll down the
spreadsheet. Here's how to freeze the header row(s):

> LibreOffice: https://help.libreoffice.org/Calc/Fr...mns_as_Headers
> OpenOffice: https://wiki.openoffice.org/wiki/Doc...ws_and_columns
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can we edit/update club competition histories now via updater?
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getting there lads,

once i select a club and go along to CA, how do i get to list the ca from high to low?

thanks for the help lads 

archie,

are steps 3 and 4 saved now or do i need to do them each time i open a file?
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great guide btw,
it's Beezerproof  and that is some going 
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select the whole sheet > data > sort > by column of CA's > largest to smallest (or vice versa) 

each time mate 

 Originally Posted by BeezerCeltic1967 

getting there lads,

once i select a club and go along to CA, how do i get to list the ca from high to low?

 Originally Posted by BeezerCeltic1967 

archie,

are steps 3 and 4 saved now or do i need to do them each time i open a file?
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No, not yet.

Each time, I'm afraid. CSV doesn't save things like this.

However, if you save the spreadsheet as an XLS or possibly an ODS it should save your filters, etc.
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 Originally Posted by djole2mcloud 

can we edit/update club competition histories now via updater?

 Originally Posted by BeezerCeltic1967 

are steps 3 and 4 saved now or do i need to do them each time i open a file?
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how do you do that? 

open office is doing my head in, keeps fucking freezing....

also when i eventually manage to get the ca's in descending order, is there any way of moving that row along to the players surname
so you can easily see which player has which ca without scrolling back and forth?

cheers
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select the whole sheet > data > sort > by column of CA's > largest to smallest (or vice versa) 
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Just use the drop down arrow on the CA header cell and click on sort ascending/descending. But yeah it does take a while to sort in
Open/LibreOffice.

I'm on my iPad right now so can't post a screenshot, but what you can do is select the columns you want to hide and then there will
be a Hide Columns button somewhere (possibly by right-clicking on the selected columns). By hiding the columns you don't want to
see, you can get the CA column nearer the player names columns.
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to select the whole sheet just click on the small cell between row 1 and column A, it works in excel and should work in openoffice too 

Director

 Originally Posted by BeezerCeltic1967 

how do you do that? 

open office is doing my head in, keeps fucking freezing....

also when i eventually manage to get the ca's in descending order, is there any way of moving that row along to the players surname so you
can easily see which player has which ca without scrolling back and forth?

cheers
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cheers for the help lads 

one more thing 

say for example i want to view all the players in holland with a ca between 120 and 140, how would i go about that? and could i then
save and export it? so i could refer to it as and when? deleting players in the exported sheet once i had tweaked them in my wee DB?
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with a non player update sheet u can't edit players club?move it from one to
another,right?
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Click on the drop-down arrow on the CA header cell (when using the Auto-filter like I explained before) -> click on the button that says
Standard Filter and then setup the options like this (but obviously you should select the Dutch league rather than the English Premier
Division in my screenshot):

Once you have your spreadsheet suitably filtered:

1. Press Ctrl+A to select the entire spreadsheet and then press Ctrl+C to copy to the clipboard.

2. Create a new blank spreadsheet and press Ctrl+V. This will paste the filtered data into your new spreadsheet.

3. Save your new spreadsheet as an ODS or XLS spreadsheet.

No, the non-player file edits non-player attributes.

 Originally Posted by BeezerCeltic1967 

cheers for the help lads 

one more thing 

say for example i want to view all the players in holland with a ca between 120 and 140, how would i go about that? and could i then save and
export it? so i could refer to it as and when? deleting players in the exported sheet once i had tweaked them in my wee DB?

 Originally Posted by djole2mcloud 

with a non player update sheet u can't edit players club?move it from one to another,right?
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Is there ever a situation where you would want to add an entry to a player's career history where he has played 0 games? I need to
know so that I can decide whether to add an error check preventing any entries from being imported where zero appearances have
been entered.
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Yes there are times it is needed. A non EU probably should have his Club history added even though he hasnt played any games so
that he obtains a work pemrit in game quicker, instead on his loan moves abroad.

Or do you mean total history combined equalling 0 games?

Champman0102.co.uk Facebook Page
13000 followers and rising

November 2020 Data Update Out Now
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Thanks! That's exactly what I needed to know.
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see if you are filtering and you make a mistake, is there any easy way of going back one step? instead of having to exit and reload the
sheet again?

- - - Updated - - -

edit,

just seen Undo Filter, i clicked it and it looks like it's back to start of sheet 
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I've pretty much got player career history injection sorted. I just need test it (hopefully straightforward) and get the table re-sorting
finished (this is a simple 5-10 minute coding task). With this done, it won't take very long to get league competition history injection up
and running. Then I'll move on to staff/contract updating (editing only - not injection at this stage) and will finalise the UI. Pending any
disastrous bugs, hopefully I'll have a new version online before December (subject to my work schedule and available time at
weekends).
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Two bits of progress news:

1) Good news: The player career history injection is up and running! I haven't tested it in game yet, but it seems to load fine in the
Official Editor. Injecting 128,599 new entries from a csv file took under 2 seconds which is far quicker than I'd expected.

2) Bad news: Club competition history injection is up and running but it causes an error in the Official Editor. I'm going to have to spend
some time getting to the bottom of the error. It might just be because I was injecting data for years after the 2000/01 season (I
noticed the Editor doesn't like post-2000 data). I will do some testing later, but I thought in the mean time I'd post the error message
in case anybody knows what it means (you'll see in the screenshot below that I left some of the fields blank - could this be the cause
of the problem?):
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is this helpful?
3.12 tapani patch has option to patch official editor year...could u extract that and implement it somehow to your tool...

 Originally Posted by archibalduk 

Two bits of progress news:

1) Good news: The player career history injection is up and running! I haven't tested it in game yet, but it seems to load fine in the Official
Editor. Injecting 128,599 new entries from a csv file took under 2 seconds which is far quicker than I'd expected.

2) Bad news: Club competition history injection is up and running but it causes an error in the Official Editor. I'm going to have to spend some
time getting to the bottom of the error. It might just be because I was injecting data for years after the 2000/01 season (I noticed the Editor
doesn't like post-2000 data). I will do some testing later, but I thought in the mean time I'd post the error message in case anybody knows
what it means (you'll see in the screenshot below that I left some of the fields blank - could this be the cause of the problem?):
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do u have blank rows below last year injected?...if i see well u have under 2014 a blank row...i always get this error when i insert comp
history via history project tool and when i left last row blank...
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Is "CM0102 Updater v0.0.3" still the latest version for download, or is there a more recent one?

This tool looks amazing. fantastic work honestly
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There is always a blank row on each screen in the Editor. I think this is simply where you enter new entries into the DB.

It looks like the error isn't necessarily anything to do with the Updater. The error appears even with an unedited copy of the October
2014 DB. So it might not be anything to worry about - but more testing and some in-game testing is still needed.

Yes, that's the latest version. 

#187

Reserve Team Player
archibalduk 

 Originally Posted by djole2mcloud 

do u have blank rows below last year injected?...if i see well u have under 2014 a blank row...i always get this error when i insert comp history
via history project tool and when i left last row blank...

 Originally Posted by edcrowley100 

Is "CM0102 Updater v0.0.3" still the latest version for download, or is there a more recent one?

This tool looks amazing. fantastic work honestly

16-11-14, 12:11 AM

Join Date:
Posts:

27-08-14
308

I havent seen this screen anywhere tho when i've used the updater... how do i view this.....?
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it is open office,not updater...an exported .csv file from updater opened through open office

 Originally Posted by edcrowley100 

I havent seen this screen anywhere tho when i've used the updater... how do i view this.....?

16-11-14, 01:57 AM

Join Date:
Posts:

27-08-14
308

ah, i suspected as much, cheers
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this also happens everytime you click on a 'cell' of a club competition history in the official editor, whether you edit something or not.

i have no idea what it means but as far as i know it never causes any issues in the game

 Originally Posted by archibalduk 

16-11-14, 04:30 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Excellent. Thanks for confirming. 
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Reserve Team Player
archibalduk 

 Originally Posted by milo 

this also happens everytime you click on a 'cell' of a club competition history in the official editor, whether you edit something or not.

i have no idea what it means but as far as i know it never causes any issues in the game

16-11-14, 08:07 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

I've started work on the staff_update file (actually, I've nearly finished it already). There are some things that will not be editable in
the first version (e.g. Staff Classification and Job for Club), but we will still be able to edit DOB, nationality, club/nation contracted to,
date joined club/nation, contract expiry, etc. It also won't be possible to create/inject new staff in this first version - it'll be editing
only to start with.

Hopefully I'll have the staff_update function completed over the next few days (day job permitting) and I can then get on to doing
some proper testing and finalising the UI.
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Reserve Team Player
archibalduk 

16-11-14, 11:08 PM

Join Date:
Posts:

27-08-14
308

I'm in the middle of importing staff file, once i'd selected the staff file, the program has been unresponsive now for like 40 mins...??

I understand the staff file is pretty large, so i'm guessing it might just be taking ages, the program is saying (Not Responding)

Is this normal, should I be worried or have i just not done it right?
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20-11-14, 03:39 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

The delete option works very well 
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ha ha ha..... yeah, its really fast too!
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 Originally Posted by Dermotron 

The delete option works very well 
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really?
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 Originally Posted by Dermotron 

The delete option works very well 

20-11-14, 06:16 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

Yep. Empty DB. https://www.sendspace.com/file/av22st

Added a couple of players to stabilise the DB (and fix the Giorgos Ismail 'bug'). Totally empty DB in 30 seconds. I left Comp Histories in
this one.
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cool stuff...so league patched DB i can erase,and import data from unpatched and save tons of time used for patching?
what does mean empty DB,only staff erased or clubs also?
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Posts:
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ok,even better...so,the only thing then is to match different club names in those two
DB...
nice idea...
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21-11-14, 09:07 AM

Join Date:
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I thought that importing players to specific clubs isn't available yet? Or did I miss that in a recent update?
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First Team Player
Jesus 

21-11-14, 09:43 AM

Join Date:
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Posts:

15-12-11
Your Mother

29,995

It isn't, there is still an old importer JL knock together that works if you take the time to learn how to use it.
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my favourite tool of all times,along with city,stadium and club import tool... :-)

 Originally Posted by Dermotron 

It isn't, there is still an old importer JL knock together that works if you take the time to learn how to use it.

21-11-14, 10:50 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

Annoyingly I've had the week from hell and have had no time to work on the Updater. I should be able to make decent progress this
weekend however.

I thought most of it still caused a crash?

You can't import the staff file. The process will be taking so long because the staff xml file is hundreds of megabytes. If it manages to
get to the end of the file it'll then show an error that the file cannot be imported. There will be a progress bar in the next version to
show how the loading process is going.

#205

Reserve Team Player
archibalduk 

 Originally Posted by Dermotron 

The delete option works very well 

 Originally Posted by edcrowley100 

I'm in the middle of importing staff file, once i'd selected the staff file, the program has been unresponsive now for like 40 mins...??

I understand the staff file is pretty large, so i'm guessing it might just be taking ages, the program is saying (Not Responding)

Is this normal, should I be worried or have i just not done it right?

22-11-14, 03:43 AM

Join Date:
Posts:

27-08-14
308

Right, ok....

So will this be possible at some point, by using you tool?

For example, lets say, I delete all the player and staff from a tapanified DB, and want to import Player and staff from another, could I
do this?
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Reserve Team Player
eddieC 

22-11-14, 03:45 AM

Join Date:
Posts:

27-08-14
308

Hope you're ok dude?
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eddieC 

 Originally Posted by archibalduk 

Annoyingly I've had the week from hell and have had no time to work on the Updater. I should be able to make decent progress this
weekend however.

22-11-14, 11:32 AM

Join Date:
Location:
Posts:

14-06-14
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Is there any interest in testing a near completed version of the Updater? I mean some genuine interest in testing the new updating
spreadsheets and checking that things appear correctly in-game and in the Official Editor - and also trying to "break" the Updater (i.e.
to see if will do things it shouldn't). I will of course do some testing myself, but it would be really helpful if a couple of users with more
familiarity of DB editing could help out.

I have a list of things I want to have done for the upcoming version and am getting very close to completing that list. I was thinking I
could upload a version with nearly all things ticked-off the list for people to test. Then I can continue getting those final things ticked
off and added to the Updater along with fixes for any bug that users report.

Eventually, yes. I'm working on the staff updating at the moment and it will hopefully be complete today. However, it will only update
existing staff rather than insert new staff. Inserting staff is a little more complex and so I want to get the editing aspect done first
before moving on to inserting. I must point out however that I'll soon be taking a break from the CM Updater whilst I work on other
projects for a while - so I imagine staff insertion won't be done until some point before next year. But it is very high on my to-do list.

Yeah, I'm good. Thanks for asking. 

I'm a trainee solicitor and am currently working in corporate law which is renowned for its long hours. Last week I was lucky to be home
before 9pm (and often closer to 11pm).

 Originally Posted by edcrowley100 

Right, ok....

So will this be possible at some point, by using you tool?

For example, lets say, I delete all the player and staff from a tapanified DB, and want to import Player and staff from another, could I do this?

 Originally Posted by edcrowley100 

Hope you're ok dude?

22-11-14, 12:19 PM

Join Date:
Posts:

02-03-12
3,608

i can help 
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Also here and keen to help...
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Thanks guys.  Hopefully I can get a test version out next weekend.

What is the earliest season you think you will need to enter when updating players' career histories and club competition histories? I
have set the limit at the year 1700 right now (i.e. if you try to import an entry with a year earlier than 1700 the Updater will throw an
error). Is that reasonable?

Last edited by archibalduk; 23-11-14 at 02:16 PM.
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The exponent problem is because of the way Excel deals with numbers in CSV files. I've found a way round it by pre-pending budgets
with the "£" symbol. They now appear correctly in Excel along with thousand separators. Annoyingly this isn't possible in XML and so
the budgets will appear just as numbers (but at least not as exponents).

The second issue I haven't been able to recreate. The budgets appear to export correctly in both CSV and XML. Everton's budget
appears as £11,812,500 in my tests.

 Originally Posted by milo 

- the cash column only shows until 999.999, beyond that an exponent is showed.

- also, some of them are bugged, for example everton have 1.181.250.000.000 £ while they have 11.812.500 £ in the editor (1/100.000)
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i know one player who began his career in 1694....

thanks for the other thing 
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 Originally Posted by archibalduk 

Thanks guys.  Hopefully I can get a test version out next weekend.

What is the earliest season you think you will need to enter when updating players' career histories and club competition histories? I have set
the limit at the year 1700 right now (i.e. if you try to import an entry with a year earlier than 1700 the Updater will throw an error). Is that
reasonable?
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I'll leave it at 1700 then! 
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I've managed to make a lot of progress today and so I'm ahead of where I expected to be.

Here is version 0.0.4: http://1drv.ms/1uXZNfP

As I mentioned previously, this version is for testing purposes only. It is not suitable for use on live databases, etc. The user
interface is a mess at the moment and is next on my to-do list. You'll see things like the Mass Edit screen don't work right now and
various icons are duplicated or blue squares. However, the importing functions are up and running and so now seems a good time to
upload it for some testing.

If you would like to help with testing, here is what you need to do:

Some things to keep an eye out for and to note generally:

- If you left a cell blank in the Updater spreadsheet, check that the original setting is preserved in the DB. E.g. if you edited a couple
of Wayne Rooney's attributes in the player_update spreadsheet, check that those you didn't update remain unaffected. I found a
possible bug with v0.0.3 where leaving a cell blank might reset those unedited attributes to zero (but it is fixed now).

- Can you break the Updater? E.g. what happens if you try to enter a national team in the Club Contracted field or if you try to edit a
player via the nonplayer_update file?

- Note that the Name Lengths setting (see File -> Settings) affects whether you should use Long or Short names for teams in the
various spreadsheets. This should not affect league names in the Club_Comp_History_Update file (league long names should always be
used) - but I need to check that the Short Names setting doesn't affect league names.
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1. Load the Updater and click on Spreadsheet -> Create Templates to create all of the spreadsheet templates. You can choose whether to
create CSV or XML templates via the File -> Settings screen.

2. Once you have created the templates, it is just a case of trying them out. Try doing different things and importing the data into a spare copy
of a database. Then check that the changes have been made correctly via an editor (e.g. the Official Editor or Tri Wasano's Editor). If the
changes appear ok then try creating a new game in CM to check that the changes work and the game doesn't crash.
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- You can change how the Updater behaves via the File -> Settings screen:
http://www.champman0102.co.uk/showth...649#post187649

- When importing large XML/CSV files you'll see that the progress bar freezes at around 80-99%. Just be patient and it'll reach 100% -
annoyingly I haven't yet been able to get the progress bar to increment properly when loading the files.

- If you want to check out the Attribute Stats graph, note that you must click on Refresh Data when viewing the graph otherwise
you'll find that half of the graph is cut-off. I haven't yet gotten to the bottom of this bug.

Here is a brief run-down of the various updater spreadsheets (note that unless I have listed a field as mandatory (see Mandatory Fields
below) then you can leave that cell/field blank if you don't want to edit it or set a value):

Career_History_Update
What it does: Insert/inject new player career history entries. This should only work for players. The Updater should give an error if you
try to add entries for non-players. You will see that the order of the columns is in the same format as that used in the Player Histories
Thread: http://www.champman0102.co.uk/showthread.php?t=865
Mandatory fields: Player name, dob and year
Club field: You can leave this blank or alternatively enter "_none" or "_unknown" if you don't want a club assigned (I haven't checked
that this works in game yet, but I hope it appears as something like Unknown Club in game).
On Loan field: Y / Yes / 1 = On loan and N / No / 0 = Not on loan (you can also leave this field blank and it will be treated as not on
loan).
IMPORTANT: If you're going to import a very large amount of data (e.g. several thousand entries), use a csv file rather than xml (xml
is very slow with large numbers of rows).

Club_Comp_History_Update
What it does: Insert/inject new domestic and international league/tournament histories.
Mandatory fields: Competition, year and winners

Nonplayer_Update
What it does: Edit non-player attributes.
Mandatory fields: Non-player name and dob
Preferred player models: It is well worth testing this. E.g. what happens if you enter the name of a non-player? You can remove a
preferred player model by entering "_none" in any of the three name fields for that model (i.e. any of the First Name, Second Name or
Common Name fields). It is worth checking that this "_none" setting does in fact work.

Official_Update
What it does: Edit official/referee attributes, birth place, nationality, etc.
Mandatory fields: Official name and dob
City editing: To edit an official's city, you must also enter the city's nation in the appropriate field (it's the cell to the right of the City
cell).

Player_Update
What it does: Edit player attributes.
Mandatory fields: Player name and dob

Staff_Update
What it does: Edit various data for players and also non-players - e.g. nationalities, club/nation contracted, wages, contract expiry,
etc. It is also possible to edit some basic player and non-player attributes such as squad number, CA, PA, reputations and positions.
Mandatory fields: Staff name and dob
Nationalities and club/nation contracted: You can make a player a free agent by entering "_fa", "_free", "_free_transfer", "_none",
"_ufa" or "_none" in Club/Nation Contracted. You can also enter any of the same values in Nationalities cells in order to remove a
player's Primary/Secondary Nationality.
Fields that don't yet work: Please note that the following cells can be ignored because they do not yet do anything: Mode,
Classification, Job For Club, Club Valuation, Playing Squad, Euro Squad and Job For Nation.

Last edited by archibalduk; 23-11-14 at 10:50 PM.
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I have updated the post above.

P.s. I have done some of my own basic testing and it seems ok. However, it really needs some more in-depth testing (and I haven't
had the chance to do so yet because I'm still working on the coding). The Staff_Update particularly needs some real testing. I will do
some further testing once I have the UI finished - but if anybody can do some testing too then that'd be such a big help for me. If
anybody does any testing, please let me know roughly what sorts of things you've tested. 
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Perhaps people were getting a crash when they reopened the editor? Or loaded the game. Then yes that would occur if you remove
everything, the game needs a set amount of club comp histories. The other thing it needs it one member of staff and one official. After
deletion our old friend Giorgios Ismail is the only staff and official in the DB. No idea how this name came up but whenever our data
gets messed up old Giorgi boy appears.

But you can check the DB I posted on the previous page, it works fine, it just needs some staff.

Champman0102.co.uk Facebook Page
13000 followers and rising

November 2020 Data Update Out Now
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I thought most of it still caused a crash?
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archie, maybe i'm stupid, blind or both... but i can't see the import button in your 0.0.4 so i don't know how to test anything...
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well i had some testing 

this is fine, no blank cells left 

it gives you an error (creating an error excel file) and nothing is updated into the db 

again an error (no match) and nothing updated 
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 Originally Posted by archibalduk 

- If you left a cell blank in the Updater spreadsheet, check that the original setting is preserved in the DB. E.g. if you edited a couple of Wayne
Rooney's attributes in the player_update spreadsheet, check that those you didn't update remain unaffected. I found a possible bug with v0.0.3
where leaving a cell blank might reset those unedited attributes to zero (but it is fixed now).

 Originally Posted by archibalduk 

- Can you break the Updater? E.g. what happens if you try to enter a national team in the Club Contracted field

 Originally Posted by archibalduk 

or if you try to edit a player via the nonplayer_update file?
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i also tried to:

- give illogical values for attributes, e.g. 22,19 or 150 or -888:
nothing is updated (as if i made no changes), giving me some errors in the error file (although telling me they are different errors, e.g.
goolkeeper when i actually edited phisioterapy) 

- set a wrong nationality (a club instead):
it gives me a no match error, nothing updated 

- set a wrong classification (a club):
it gives me no errors but nothing is updated 

- set a fantasy club:
no errors found but it makes the non-player unattached 

this works but of course it doesn't overwrite the season, it creates 2 lines for the same season, so an edit tool would be needed 

it does insert competition, year and winner but:
a) it doesn't recognize full names of competition (tried that and gives a no match in the error file); it works with the short name but if
you update premier division, which one does it update in the db?
b) it doesn't overwrite old winners, it just creates a new line so, for example, you will have 2 winners, runners up and 3rd ranked in a
given year; host is ignored, even if set, where it's not available (e.g. a national championship).

- i set a non-player and it gives a no match error, nothing updated 

- i set _none to remove a preferred player and it gives a no match error, nothing updated so this doesn't work 

can't get this to work, it always gives me a no match error so i can't update anything 

it works 

 Originally Posted by archibalduk 

Career_History_Update
What it does: Insert/inject new player career history entries. This should only work for players. The Updater should give an error if you try to
add entries for non-players. You will see that the order of the columns is in the same format as that used in the Player Histories Thread:
http://www.champman0102.co.uk/showthread.php?t=865
Mandatory fields: Player name, dob and year
Club field: You can leave this blank or alternatively enter "_none" or "_unknown" if you don't want a club assigned (I haven't checked that this
works in game yet, but I hope it appears as something like Unknown Club in game).
On Loan field: Y / Yes / 1 = On loan and N / No / 0 = Not on loan (you can also leave this field blank and it will be treated as not on loan).
IMPORTANT: If you're going to import a very large amount of data (e.g. several thousand entries), use a csv file rather than xml (xml is very
slow with large numbers of rows).

 Originally Posted by archibalduk 

Club_Comp_History_Update
What it does: Insert/inject new domestic and international league/tournament histories.
Mandatory fields: Competition, year and winners

 Originally Posted by archibalduk 

Nonplayer_Update
What it does: Edit non-player attributes.
Mandatory fields: Non-player name and dob
Preferred player models: It is well worth testing this. E.g. what happens if you enter the name of a non-player? You can remove a preferred
player model by entering "_none" in any of the three name fields for that model (i.e. any of the First Name, Second Name or Common Name
fields). It is worth checking that this "_none" setting does in fact work.

 Originally Posted by archibalduk 

Official_Update
What it does: Edit official/referee attributes, birth place, nationality, etc.
Mandatory fields: Official name and dob
City editing: To edit an official's city, you must also enter the city's nation in the appropriate field (it's the cell to the right of the City cell).

 Originally Posted by archibalduk 

Player_Update
What it does: Edit player attributes.
Mandatory fields: Player name and dob

 Originally Posted by archibalduk 

Staff_Update
What it does: Edit various data for players and also non-players - e.g. nationalities, club/nation contracted, wages, contract expiry, etc. It is
also possible to edit some basic player and non-player attributes such as squad number, CA, PA, reputations and positions.
Mandatory fields: Staff name and dob
Nationalities and club/nation contracted: You can make a player a free agent by entering "_fa", "_free", "_free_transfer", "_none", "_ufa"
or "_none" in Club/Nation Contracted. You can also 
enter any of the same values in Nationalities cells in order to remove a player's Primary/Secondary Nationality.

https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=208470#post208470
http://www.champman0102.co.uk/showthread.php?t=865
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=208470#post208470
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=208470#post208470
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=208470#post208470
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=208470#post208470
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=208470#post208470


- it works 

- but trying to update the nation contracted cell it does update that in the db, i.e. i added rooney to brazil (picture below) and he has
an unknown role (as the job for nation function is off).
i reckon this can cause some errors in game although it was fine in my test.

also, what is euro squad for?

enter any of the same values in Nationalities cells in order to remove a player's Primary/Secondary Nationality.
Fields that don't yet work: Please note that the following cells can be ignored because they do not yet do anything: Mode, Classification, Job
For Club, Club Valuation, Playing Squad, Euro Squad and Job For Nation.
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Yes, I believe he signed for Henry VIII FC on a bosman transfer
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Milo - Thanks a million!  You have saved me so much time.

It looks like it's another week of long working hours, but I'll be able to work on the issues you raised this weekend. The official_update
and the preferred player model updating used to work before - I suspect something I did whilst working on the staff_update knocked
something out (most likely the Match Function which matches up the text entered into the spreadsheet with data in the DB - I
subsequently modified this somewhat in order to accommodate certain aspects of the staff_update).

Regarding club_comp_update, I suspect the Short/Long Names setting is affecting what competition names the Updater is accepting.
That's an easy fix. Both club_comp_update and career_history_update are designed to inject new entries rather than update existing
entries. For club_comp_update I can make it update rather than inject if an entry for a particular season already exists in the DB -
would this be helpful? Is there ever a time when you would want to have two entries for a particular season for a particular
competition?

I'll check out the issue about the illogical values for attributes. Actually no error should be flagged at all - it should just skip them. Also,
setting a non-existent club shouldn't make the player/non-player a free agent - it should leave him on his current team and just flag up
a NO MATCH error. So that's something else I need to check out.

That's a really good point about the Job For Nation field. I guess we shouldn't be able to set Nation Contacts for players. I'll sort this
out for the next build.

Regarding the Euro Squad field - it's something that is only used in a saved game. But seeing as it is in the DB (but not used), I
thought I'd include it. It might come in useful if/when I get saved game editing up and running. My guess is that this field sets whether
the player is declared for the team's Champions League, etc squad.
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unfortunately yes, we need both a single line for a season (basically all the competitions) and a few ones that need 2 or more lines per
year (e.g. brazil where we have less state champs in game so every one represents more than one state in real life) so if you could
make two different options for this (one for overwriting/adding new years and one for adding old years without overwriting) would be
perfect 

about the illogical values, there is nothing wrong in my opinion (maybe i wasn't very clear in my sentence before), it simply ignores you
if you type odd numbers in (although it would be better to have an error instead maybe, so you can realize what was wrong in your
importing).
the problem i was talking about is if you make an impossible change about an attribute (for example patience) it does tell you that you
have made an error but it refers to a different one (i.e. the header in excel is goalkeeping, and not patience).

also, i forgot to say that in the non-player spreadsheet the headers of the preferred formation's player are too close to the following
role so you can't read the role it is referred to (i.e. you can just see "Preferred Player Model" but not goalkeeper, sweeper, etc. so you
need to select that cell everytime...).

thanks for all your hard work anyway and i forgot to say that i love your new interface, really nice, simple and accurate 

 Originally Posted by archibalduk 

Regarding club_comp_update, I suspect the Short/Long Names setting is affecting what competition names the Updater is accepting. That's an
easy fix. Both club_comp_update and career_history_update are designed to inject new entries rather than update existing entries. For
club_comp_update I can make it update rather than inject if an entry for a particular season already exists in the DB - would this be helpful? Is
there ever a time when you would want to have two entries for a particular season for a particular competition?

 Originally Posted by archibalduk 

I'll check out the issue about the illogical values for attributes. Actually no error should be flagged at all - it should just skip them. Also, setting a
non-existent club shouldn't make the player/non-player a free agent - it should leave him on his current team and just flag up a NO MATCH
error. So that's something else I need to check out.
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Yeah, i second that
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 Originally Posted by milo 

thanks for all your hard work anyway and i forgot to say that i love your new interface, really nice, simple and accurate 
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Another really hard week at work (lucky to be home before midnight most nights) but
thankfully it should be quieter next week. Anyhow, I've been going through Milo's really
helpful post and making various minor fixes to the Updater (see notes below). I'm going
to have a look at the Job For Nation/Nation Contracted issue tomorrow and hopefully I
can get another test version online tomorrow.

Club_comp_update

As suspected, the Use Short Names setting was affecting how the update was
recognising competition names. I have fixed this so that long names must always be
used for competition names (but the Use Long/Short Names setting still controls how
team names are recognised).

For the moment I'm going to keep this as an injection fuction only. I want to keep things
reasonably simple to start with and also I want to think about how best to have a
spreadsheet that allows both updating and injecting. The goes with staff_history_update
for the time being.

If you want to edit club competition history, you can:

1) Export the club competition history from the DB;
2) Delete the club competition history from the DB (using the Mass Edit screen);
3) Make the desired changes to the exported spreadsheet (i.e. add/delete/edit entries);
4) Import the spreadsheet back into your DB.

Essentially you're exporting your data, making changes, erasing the old data and
replacing with your updated data.

Nonplayer_update

Fixed (along with another related bug and a bug with leaving the Preferred Formation
field blank).

The Goalkeeper error will be an error relating to the Goalkeeper Preferred Player Model
rather than the attributes.

I found that setting attributes above 20 or below 0 was actually setting the attributes
to the incorrect values. In re-writing the code I'd clearly forgotten to add this check. It
is fixed now.

#226

Reserve Team Player
archibalduk 

 Originally Posted by milo 

it doesn't recognize full names of competition

 Originally Posted by milo 

i set _none to remove a preferred player and it gives a no match error, nothing updated
so this doesn't work

 Originally Posted by milo 

give illogical values for attributes, e.g. 22,19 or 150 or -888: nothing is updated (as if i
made no changes), giving me some errors in the error file (although telling me they 

are different errors, e.g. goolkeeper when i actually edited phisioterapy)
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I have renamed the header titles. Hopefully they're a bit easier to read.

Official_update

It works for me. Could you upload your official_update file or email it to me please?
archibalduk AT gmail.com

Staff_update

I get a NO MATCH error when setting a non-existent club (and the player or non-player
remains attached to his existing club). However, I found a bug with players/non-players
being set unattached if you leave the Club/Nation Contracted blank. This is now fixed.

I'm going to prevent players from having a Contracted Nation. I'm also going to enable
Job For Club/Nation editing and some validation so that a non-player always has a Job
For Nation if they're contracted to a nation.

 Originally Posted by milo 

also, i forgot to say that in the non-player spreadsheet the headers of the preferred
formation's player are too close to the following role so you can't read the role it is 

referred to (i.e. you can just see "Preferred Player Model" but not goalkeeper, sweeper,
etc. so you need to select that cell everytime...).

 Originally Posted by milo 

can't get this to work, it always gives me a no match error so i can't update anything

 Originally Posted by milo 

set a fantasy club: no errors found but it makes the non-player unattached

 Originally Posted by milo 

but trying to update the nation contracted cell it does update that in the db, i.e. i added
rooney to brazil (picture below) and he has an unknown role (as the job for nation
function is off). i reckon this can cause some errors in game although it was fine in my
test.
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Unfortunately I haven't gotten quite as far as I'd planned. I'm want to do some more testing before I release the next test version.
Subject to what my job is like next week, I might be able to get the next test version online before next weekend.
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 Originally Posted by archibalduk 

I'm going to have a look at the Job For Nation/Nation Contracted issue tomorrow and hopefully I can get another test version online tomorrow.

01-12-14, 04:34 PM

Join Date:
Posts:

02-03-12
3,608

tested it again, the problem is with the nationality, until you import whatever you want but nation, nationality and city it's perfect,
when you want to change nation, nationality and city it gives you a no match error and imports nothing

well, you are right 
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 Originally Posted by archibalduk 

Official_update
It works for me. Could you upload your official_update file or email it to me please? archibalduk AT gmail.com

 Originally Posted by archibalduk 

Staff_update

I get a NO MATCH error when setting a non-existent club (and the player or non-player remains attached to his existing club). However, I found
a bug with players/non-players being set unattached if you leave the Club/Nation Contracted blank. This is now fixed.

01-12-14, 10:09 PM #229
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Thanks! I'll check that out. 
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 Originally Posted by milo 

tested it again, the problem is with the nationality, until you import whatever you want but nation, nationality and city it's perfect, when you
want to change nation, nationality and city it gives you a no match error and imports nothing
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I have been making a lot of progress with the UI and fixing the various bugs we found. However, I have had less time than anticipated
and so it's going to be a while longer before I can get the next version released. The UI work is taking a lot of time.

I noticed with the October 2014 database update that the index.dat file is one byte too long (i.e. it has an extra byte at the end of
the file which is superfluous). I have made a change to the Updater so that it will automatically fix this problem when loading and
saving the database.

I have also added automatic staff/player career history validation. When loading and saving the database, the Updater will remove all
career history entries where the Year has been set to zero. The October database has nearly 100,000 of these and so it takes the
Updater about 35 seconds to delete all of them when you first load the database. However, once you have saved the database with
the histories removed, the Updater loads the fixed database as quickly as normal.
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Join Date:
Posts:

02-03-12
3,608

why does it have it? is it a bug?

#231

Director
milo 

 Originally Posted by archibalduk 

I noticed with the October 2014 database update that the index.dat file is one byte too long (i.e. it has an extra byte at the end of the file which
is superfluous).
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I've no idea. It must have been an editor or tool that was used with the October DB. If it's not causing a crash then I'm guessing it's
not a problem. In any event, the next Updater will repair it.
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 Originally Posted by milo 

why does it have it? is it a bug?
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I'm afraid I cannot recreate this error. Can you upload your spreadsheet or post a screenshot of it?

Here is an example of different combinations I tried - and all of them worked:

EDIT: Just to clarify that the screenshot above is about Official updating (and not Staff updating).

Last edited by archibalduk; 14-12-14 at 02:38 PM.

 Originally Posted by milo 

tested it again, the problem is with the nationality, until you import whatever you want but nation, nationality and city it's perfect, when you
want to change nation, nationality and city it gives you a no match error and imports nothing
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wow, you can even state what City a player was born??? wish that showed in the game somehow
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Why does it say '1' for current ability, how does that translate in the editor?
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I had a query from Beezer which I thought I would answer here because it might of use to others.

I don't think you can 100% achieve what you're looking to do, but you can get fairly close. I guess what you're looking for is to
compare two DBs and apply the differences to one of them. This cannot be done right now, but you can export all of the data from one
DB, manually choose what you want and then import it into another DB.

The best thing to do in the future is to make all of your changes in Updater spreadsheets as far as possible. Then you can import your
spreadsheets into any future DB. The only difficulty here is that the Updater cannot create new players yet.

1. Transferring contracts/transfers from one DB to another
What we want to do is transfer contract details/transfers from the Source DB to the Destination DB.

> Load the Source DB in the Updater.
> Click on the Data tab and select Staff (Updater Format) from the Export Data drop-down menu. Click on the Export button and
save the file as a csv file (because xml will result in larger and slower files). Then exit the Updater.
> Rename the exported file to staff_update.csv so that it can be imported into another DB.
> Make any changes you want in the spreadsheet (e.g. remove entries you don't want to import, etc).
> Load the Destination DB.
> Click on Data -> Import and select your staff_update.csv file.
> Save the Destination DB.

2. Transferring player attributes from one DB to another
What we want to do is transfer all player attributes from the Source DB to the Destination DB.

> Load the Source DB in the Updater.
> Click on the Data tab and select Player Attributes (Updater Format) from the Export Data drop-down menu. Click on the Export
button and save the file as a csv file (because xml will result in larger and slower files). Then exit the Updater.
> Rename the exported file to player_update.csv so that it can be imported into another DB.
> Make any changes you want in the spreadsheet (e.g. remove entries you don't want to import, etc).
> Load the Destination DB.
> Click on Data -> Import and select your player_update.csv file.
> Save the Destination DB.

 Originally Posted by BeezerCeltic1967

as you may or may not know i have released a data update, http://www.champman0102.co.uk/showth...2&goto=newpost

the thing is, all that work will be lost unless i can merge it with our jan update that we will release, would this be possible? so that my changes
to players attributes are kept, but also the transfers from the jan update are in it? if you get what i mean? because as soon as i download
another DB over the top of this one then the changes i have made will be lost and i really don't want that. i know i can save this DB and then
use it again but it wont have our jan work in it.

cheers
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No, it's just for officials I'm afraid. The screenshot is for officials. Although I do find it weird how they have birth cities for officials but
not for any staff.

It was just me doing a quick test to check that various parts of the Official updating work correctly. The 1 will translate to a 1/200
Current Ability which is pretty darn low! 
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 Originally Posted by edcrowley100 

wow, you can even state what City a player was born??? wish that showed in the game somehow

 Originally Posted by edcrowley100 

Why does it say '1' for current ability, how does that translate in the editor?
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ah, right.... of course, I wondered why I didn't recognise any of the names... duh!!!

well the game needs to know the refs city of origin of course, as that matters, It doesn't for players

14-12-14, 03:05 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

#239

Reserve Team Player
archibalduk 

https://champman0102.co.uk/showthread.php?t=5288&s=ce04dd1b8f151bd01733efaa679ba425&p=211249#post211249
https://champman0102.co.uk/member.php?u=49477&s=ce04dd1b8f151bd01733efaa679ba425


Here is version 0.0.5: http://1drv.ms/1srzOKD

This is probably going to be the last release for a little while. I need to move on to some roster updating and Updater work for Eastside
Hockey Manager. However, I will be picking up the CM Updater again afterwards and will continue to develop various new features for it
(such as staff injection). Please do continue to post feedback here and I will pick up as soon as I recommence work on the tool. If we
come across any bugs then I'll push out a fixed version asap.

PLEASE NOTE: If your DB has a lot of invalid player career history entries (i.e. entries with the Year set to zero) then there
will be a pause whilst loading the DB. The pause can be up to 45 seconds depending on the number of invalid entries (e.g. with the
October 2014 DB there is roughly a 30 second pause as there are nearly 100,000 invalid entries). The pause is because the Updater is
deleting all of the invalid entries. When you next save the DB in the Updater it will save it without these invalid entries. The DB will load
as quickly as before when you load a DB without any invalid entries.

A rough changelist is as follows:
Fixed various minor bugs
Improved UI (but still a work in progress - especially the Settings screen)
Automatic index.dat repair if extraneous bytes are present at the end of the file
Automatic removal of invalid player career history entries
Players will no longer have a contracted nation. Job For Club will be copied to the non-player's Job For Nation when
contracting a non-player to a nation via staff_update

Minimum Requirements
You must have the Microsoft Visual C++ 2010 Redistributable Package installed otherwise you'll encounter a crash when you
try to load a database in the Updater. Here's the download link: http://www.microsoft.com/en-us/downl...s.aspx?id=5555

Installation
Simply extract the contents of the downloaded zip file into a folder of your choice. You'll see that the zip file consists of the exe and a
number of dll files (including a 'platforms' sub-folder which consists of 3 further dll files).

If you're going to edit and save a database located in C:/Program Files/../ then you must use 'Run as Admin' to load the Updater -
otherwise it won't be able to save your database properly (as with any other editor, if you don't use Run as Admin for a database in
Program Files, you'll end up with a shadow copy in your /Users/Roaming/ folder which is a real pain). Also, you must always use 'Run as
Admin' if you install the Updater to C:/Program Files/../ (otherwise it won't be able to save your settings to its config file).

Career_History_Update
What it does: Insert/inject new player career history entries. This should only work for players. The Updater should give an error if you
try to add entries for non-players. You will see that the order of the columns is in the same format as that used in the Player Histories
Thread: http://www.champman0102.co.uk/showthread.php?t=865
Mandatory fields: Player name, dob and year
Club field: You can leave this blank or alternatively enter "_none" or "_unknown" if you don't want a club assigned (I haven't checked
that this works in game yet, but I hope it appears as something like Unknown Club in game).
On Loan field: Y / Yes / 1 = On loan and N / No / 0 = Not on loan (you can also leave this field blank and it will be treated as not on
loan).
IMPORTANT: If you're going to import a very large amount of data (e.g. several thousand entries), use a csv file rather than xml (xml
is very slow with large numbers of rows).

Club_Comp_History_Update
What it does: Insert/inject new domestic and international league/tournament histories.
Mandatory fields: Competition, year and winners

Nonplayer_Update
What it does: Edit non-player attributes.
Mandatory fields: Non-player name and dob
Preferred player models: It is well worth testing this. E.g. what happens if you enter the name of a non-player? You can remove a
preferred player model by entering "_none" in any of the three name fields for that model (i.e. any of the First Name, Second Name or
Common Name fields). It is worth checking that this "_none" setting does in fact work.

Official_Update
What it does: Edit official/referee attributes, birth place, nationality, etc.
Mandatory fields: Official name and dob
City editing: To edit an official's city, you must also enter the city's nation in the appropriate field (it's the cell to the right of the City
cell).

Player_Update
What it does: Edit player attributes.
Mandatory fields: Player name and dob

Staff_Update
What it does: Edit various data for players and also non-players - e.g. nationalities, club/nation contracted, wages, contract expiry,
etc. It is also possible to edit some basic player and non-player attributes such as squad number, CA, PA, reputations and positions.
Mandatory fields: Staff name and dob
Nationalities and club/nation contracted: You can make a player a free agent by entering "_fa", "_free", "_free_transfer", "_none",
"_ufa" or "_none" in Club/Nation Contracted. You can also enter any of the same values in Nationalities cells in order to remove a
player's Primary/Secondary Nationality.
Fields that don't yet work: Please note that the following cells can be ignored because they do not yet do anything: Mode,
Classification, Job For Club, Club Valuation, Playing Squad, Euro Squad and Job For Nation.
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Posts: 6,197

so after the jan DB is released, i could move the attributes from my DB into the jan DB and the players and transfers would be at the
correct clubs after the close of the transfer window, yet still have the changes i made to them in the fantasy DB?

that would be fucking unreal if it could happen.

 Originally Posted by archibalduk 

I had a query from Beezer which I thought I would answer here because it might of use to others.

I don't think you can 100% achieve what you're looking to do, but you can get fairly close. I guess what you're looking for is to compare two
DBs and apply the differences to one of them. This cannot be done right now, but you can export all of the data from one DB, manually choose
what you want and then import it into another DB.

The best thing to do in the future is to make all of your changes in Updater spreadsheets as far as possible. Then you can import your
spreadsheets into any future DB. The only difficulty here is that the Updater cannot create new players yet.

1. Transferring contracts/transfers from one DB to another
What we want to do is transfer contract details/transfers from the Source DB to the Destination DB.

> Load the Source DB in the Updater.
> Click on the Data tab and select Staff (Updater Format) from the Export Data drop-down menu. Click on the Export button and save the file
as a csv file (because xml will result in larger and slower files). Then exit the Updater.
> Rename the exported file to staff_update.csv so that it can be imported into another DB.
> Make any changes you want in the spreadsheet (e.g. remove entries you don't want to import, etc).
> Load the Destination DB.
> Click on Data -> Import and select your staff_update.csv file.
> Save the Destination DB.

2. Transferring player attributes from one DB to another
What we want to do is transfer all player attributes from the Source DB to the Destination DB.

> Load the Source DB in the Updater.
> Click on the Data tab and select Player Attributes (Updater Format) from the Export Data drop-down menu. Click on the Export button
and save the file as a csv file (because xml will result in larger and slower files). Then exit the Updater.
> Rename the exported file to player_update.csv so that it can be imported into another DB.
> Make any changes you want in the spreadsheet (e.g. remove entries you don't want to import, etc).
> Load the Destination DB.
> Click on Data -> Import and select your player_update.csv file.
> Save the Destination DB.
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Yeah that's exactly right. 
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 Originally Posted by BeezerCeltic1967 

so after the jan DB is released, i could move the attributes from my DB into the jan DB and the players and transfers would be at the correct
clubs after the close of the transfer window, yet still have the changes i made to them in the fantasy DB?

that would be fucking unreal if it could happen.
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Perfect 
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 Originally Posted by archibalduk 

Yeah that's exactly right. 

14-12-14, 07:37 PM

Join Date:
Location:

Posts:

02-03-12
WATING FOR 10 IN

A ROW
6,197

#243

Director
BeezerCeltic1967 

https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=211244#post211244
https://champman0102.co.uk/showthread.php?t=5288&s=ce04dd1b8f151bd01733efaa679ba425&p=211282#post211282
https://champman0102.co.uk/member.php?u=49477&s=ce04dd1b8f151bd01733efaa679ba425
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=211254#post211254
https://champman0102.co.uk/showthread.php?t=5288&s=ce04dd1b8f151bd01733efaa679ba425&p=211285#post211285
https://champman0102.co.uk/member.php?u=23&s=ce04dd1b8f151bd01733efaa679ba425
https://champman0102.co.uk/showthread.php?s=ce04dd1b8f151bd01733efaa679ba425&p=211282#post211282
https://champman0102.co.uk/showthread.php?t=5288&s=ce04dd1b8f151bd01733efaa679ba425&p=211289#post211289
https://champman0102.co.uk/member.php?u=23&s=ce04dd1b8f151bd01733efaa679ba425


what about CA/PA changes mate?
will they change over with the attribute changes would it be just attributes?
and if it was just att's could we move over ca/pa changes as well?

cheers
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It does attributes, CAs, PAs, Reps, positions, etc.

Try doing this with your database right now (or any other DB) and everything in that spreadsheet is what will be updated/transferred:

> Load the Source DB in the Updater.
> Click on the Data tab and select Player Attributes (Updater Format) from the Export Data drop-down menu. Click on the Export
button and save the file as a csv file (because xml will result in larger and slower files). Then exit the Updater.
> Close the Updater and open the csv spreadsheet you just saved/exported.
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Excellent work,

For us publishers this work is fundamental to update. Two questions, first, how do I delete players in database, can explain step by
step if possible? Second question, is there any news about the inclusion of new players through this tool?

I'm waiting for sanr my doubts, I appreciate the work and apologize for the English however am Brazilian, so it's understandable ...
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Thanks!

At the moment, players cannot be added or deleted from the database. I'm not sure when I'll have a chance to look at adding this
feature as I'm hugely busy with other projects right now. I will revisit it at some point in the future though. 

To be honest, I wasn't really sure anybody was using my tool.
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with the right amendments i think it would be very useful for the update team instead 

the amount of transfers, loans, big squads and players to be looked after rises every season, so doing everything manually as we have
always done is going to be outdated.

90% of the time an updater spends here is for mechanical things (moving a player to another team, setting an injury, updating caps,
etc.) while we would like to do more ''human'' things (updating attributes, setting the right lineups, etc.)
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Echo what milo says, the last Updater version has it's uses but without the import/export and delete options it can be some what
limited for us.

Last edited by Dermotron; 04-03-15 at 01:22 PM.
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Thanks guys. That's really useful feedback. I'm swamped with some big Eastside Hockey Manager projects right now, but I will certainly
return to the CM Updater and get player/non-player injection and deletion working. It shouldn't be too much work as I've already done
a lot of the ground work.

With regards to moving players from one team to another, this can already be done via the Updater import function (see the
staff_update.csv/xml file).
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Must have a look at the moving players option again, could be very handy
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Looking forward for injection option at updater...
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Tried using the Import option mate but keep getting "is not compatible with database editing" message. Here is the file I've used
https://www.sendspace.com/file/f1ci1u

Settings: CSV, Full Date of Birth, Long Names, Standard Text
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 Originally Posted by archibalduk 

With regards to moving players from one team to another, this can already be done via the Updater import function (see the
staff_update.csv/xml file).
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First of all, I'd just like to say thanks to archibalduk for all your great work. While I hate to add to myriads of requests, I was wondering
what the status is of making the tool backwards compatible with 00/01. I had to move some clubs around in my DB and need to update
staff histories to match. I don't fancy moving ~1000 entries around by hand. Interestingly, v0.0.1 of the tool allows me to export my
00/01 staff_history.dat as a .csv file (XML does not work), while all subsequent versions will crash when trying to export it in any
format. It seems the earlier version was able to read 00/01 well enough, but I'm sure the format had to be updated to make importing
back into 01/02 work properly. I used my v0.0.1 extraction to sift through the players and see who needs updating, but it would be
wonderful to be able to inject my changes back in en masse. Thanks.
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I've been using the CA Ranges option, nice job 

A very handy addition to this would be average of top 11 players in terms of CA by league per club. If that's possible maybe a page to
list Managers CA by league by club also would be incredibly convenient.
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What happened to the progress of this Archi? Have you been to consumed by the latest Hockey manager game? 
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That's exactly right! My EHM forum has exploded with activity and it's a full-time job trying to moderate it. It's great to see the buzz
around the new game, but it's really hampering my side projects.

I have been doing a lot of work to the underlying system and I think there are a various improvements I can move over to the CM
Updater in the not so distant future.

Can you re-upload the file so that I can take a look? I missed it the last time you uploaded it (sorry).

Just the top 11 players generally or would it be better to take say the best goalie, top 4 defenders, top 4 mids and top 2 strikers (or
thereabouts)?

At this stage I don't have any intention to make it backward compatible with 00/01. It's too much work which I'd rather, at this stage,
spend adding to the existing features (such as adding player/staff injection). Did anybody ever post details of the differences between
the CM 01/02 and 00/01 database formats? If they did, I can take a quick look and give you an idea as to whether adding backwards
compatibility is something that could be done in the future.

 Originally Posted by Jesus 

What happened to the progress of this Archi? Have you been to consumed by the latest Hockey manager game? 

 Originally Posted by Dermotron 

Tried using the Import option mate but keep getting "is not compatible with database editing" message. Here is the file I've used
https://www.sendspace.com/file/f1ci1u

Settings: CSV, Full Date of Birth, Long Names, Standard Text

 Originally Posted by Dermotron 

I've been using the CA Ranges option, nice job 

A very handy addition to this would be average of top 11 players in terms of CA by league per club. If that's possible maybe a page to list
Managers CA by league by club also would be incredibly convenient.

 Originally Posted by Dr. Conquest  

First of all, I'd just like to say thanks to archibalduk for all your great work. While I hate to add to myriads of requests, I was wondering what
the status is of making the tool backwards compatible with 00/01. I had to move some clubs around in my DB and need to update staff histories
to match. I don't fancy moving ~1000 entries around by hand. Interestingly, v0.0.1 of the tool allows me to export my 00/01 staff_history.dat as
a .csv file (XML does not work), while all subsequent versions will crash when trying to export it in any format. It seems the earlier version was
able to read 00/01 well enough, but I'm sure the format had to be updated to make importing back into 01/02 work properly. I used my v0.0.1
extraction to sift through the players and see who needs updating, but it would be wonderful to be able to inject my changes back in en masse.
Thanks.

25-04-15, 08:35 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

I'll have to dig out the file. Top 11 players is best but as a colleague of mine pointed out, top 18 would be better since squads these
days are huge.
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#257

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

 Originally Posted by archibalduk 

Can you re-upload the file so that I can take a look? I missed it the last time you uploaded it (sorry).

Just the top 11 players generally or would it be better to take say the best goalie, top 4 defenders, top 4 mids and top 2 strikers (or
thereabouts)?

.

03-08-15, 09:14 PM

Join Date:
Posts:

04-03-12
3,459

#258

First Team Player
Jesus 
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So I've been using this tool quite a bit recently and it's really effective and efficient.

Is it possible to change a player's contract so that they become a free transfer?

03-08-15, 10:40 PM

Join Date:
Posts:

04-03-12
3,459

Worked out how to do it, use _NONE for the contracted club.

#259

First Team Player
Jesus 

 Originally Posted by Jesus 

So I've been using this tool quite a bit recently and it's really effective and efficient.

Is it possible to change a player's contract so that they become a free transfer?

05-08-15, 08:40 PM

Join Date:
Location:

Posts:

02-03-12
The Great White

North
4,502

what are you working on?

#260

Manager
Programmer
Forum Enforcer
Holy Trinity Member

Craig Forrest 

05-08-15, 08:41 PM

Join Date:
Posts:

04-03-12
3,459

It will be ready... soon. 

#261

First Team Player
Jesus 

 Originally Posted by Craig Forrest  

what are you working on?

01-09-15, 11:19 AM

Join Date:
Posts:

04-06-15
27

Hi 
when I Update db with the tool all works great but when I try to edit Players Name with official editor
happens that the surname of following players disappear.

Thanks

#262

Youth Team Player
NicolaIta 

05-07-16, 02:42 PM

Join Date:
Posts:

20-09-15
304

Hi, when export city data from selected database, latitude and langtitude data comes reverse, fyi

#263

Reserve Team Player
xeno 

09-11-16, 09:16 PM

Join Date:
Posts:

23-02-13
3

Does anybody have a link for this?

#264

Youth Team Player
PedroPM 

10-11-16, 11:44 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

#265

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 
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07-09-17, 10:45 AM

Join Date:
Posts:

19-03-17
14

This tool doesn't work on win 10. Any idea how to fix it guys?

#266

Youth Team Player
markuse 

07-09-17, 03:12 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

Run as admin?

Works fine on win 10 
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#267

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

10-12-18, 06:50 PM

Join Date:
Posts:

17-03-13
19

Hello to all,

I was kindly advised by MadScientist to switch to this tool re: my request to mass add players, but I must say this tool confuses me a
fair bit, whilst I still sense it could be immensely helpful. What I want to do is (I think) less complex than what you guys have done but
I fail to see what I need to do.

I understand that I need to use a spreadsheet and to fill in the fields, but I do not understand which model or template I should use?
Are those the ones provided in the package when you create the Temporary folder?

Basically, as stated, what I wish to do is to mass create people in the game, but that wouldn't need to appear as all I wish to do is for
their names to appear in the pool for the creation of regen players when the original real ones retire. I'd be happy with a way to just
input first name, last name, nationality and DOB.

I understand this might be an odd request but I'd be immensely happy to be able to do this.

Thanks a lot for your help!

#268

Youth Team Player
PLP 

10-12-18, 07:20 PM

Join Date:
Location:
Posts:

26-09-18
Brazil

882

Im sorry it seems this tool cant mass add:

Dont know why the transfer tool is giving that error for us though when trying to add players, as i think the transfer tool has mass add
implemented.

#269

Director
MadScientist 

 Originally Posted by PLP 

I was kindly advised by MadScientist to switch to this tool re: my request to mass add players

 Originally Posted by archibalduk 

At the moment, players cannot be added or deleted from the database. I'm not sure when I'll have a chance to look at adding this feature as
I'm hugely busy with other projects right now. I will revisit it at some point in the future though. 

11-12-18, 07:34 AM

Join Date: 17-03-13

#270

Youth Team Player
PLP 
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« New guy, new league | Skills to Learn for Patching/RE? »

Posts: 19

Thanks for the answer!

I will try that again then on an other computer and will let you know, on the other thread, whether that works!

11-12-18, 11:09 AM

Join Date:
Location:
Posts:

13-06-12
Braga

55

you guys simply don't stop amazing me...
well done

#271

Decent Young Player
zeus77 

27-12-18, 03:26 PM

Join Date:
Location:

Posts:

05-03-12
Godalming, Surrey,

England
17

Where can I download this tool please?

Edit: never mind, I just found it above. Might be a good idea to add this to the Downloads section of the website.

#272

Youth Team Player
lehurleur 

10-01-19, 02:05 PM

Join Date:
Posts:

22-07-18
43

Hello,

I have tried this, done as it says, edited the updated file (in admin mode) - but it chrashes (chrashes means here that the software
closes down with no further notes) when I try to import the file, and when I check an edited player in the original editor - nothing have
been changed.

I am using Lussenhoff’s 10 years of updating database, which have 130.000 lines of players in it so it creates quite a huge XML/excel
file.

I would be happy to hear if anyone had any take on why this might be happening.

Sent from my iPhone using Tapatalk

#273

Youth Team Player
bendt-b 

10-01-19, 02:28 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

Isn't the Lussenhoff DB on v3.9.60? I do believe this program requires v3.9.68 patch
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#274

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

10-01-19, 02:40 PM

Join Date:
Location:
Posts:

20-09-18
Australia

1,725

Lussenhoff DB is indeed on .60

#275

Not Needed at the Club
jacobclear 

 Originally Posted by Dermotron 

Isn't the Lussenhoff DB on v3.9.60? I do believe this program requires v3.9.68 patch
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10-01-19, 03:25 PM

Join Date:
Posts:

22-07-18
43

I am 90% sure (I am at work) that it works with the .68 update - but I might be wrong.
You recon this is why the editor won’t load my changes into the data?

Sent from my iPhone using Tapatalk

#276

Youth Team Player
bendt-b 

10-01-19, 04:51 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

Could be.

What format did you use when exporting the existing data?
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#277

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

10-01-19, 05:40 PM

Join Date:
Posts:

22-07-18
43

I used the XML so I could open with Word (and only exported the updater sheet to update).

Sent from my iPhone using Tapatalk

#278

Youth Team Player
bendt-b 

 Originally Posted by Dermotron 

Could be.

What format did you use when exporting the existing data?
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Join Date:
Location:
Posts:

14-06-14
the English Channel

250

The Updater is only compatible with the final database structure (whichever version that was introduced by).

If it's crashing when importing the spreadsheet then try saving the spreadsheet as CSV and then importing. XML results in larger file
sizes which might result in making the Updater unstable.

Reserve Team Player
archibalduk 

11-01-19, 10:18 AM

Join Date:
Posts:

22-07-18
43

Thank you. First part - could you kindly elaborate further?

Second part: roger, checking if this work and coming back.

Sent from my iPhone using Tapatalk

#280

Youth Team Player
bendt-b 

 Originally Posted by archibalduk 

The Updater is only compatible with the final database structure (whichever version that was introduced by).

If it's crashing when importing the spreadsheet then try saving the spreadsheet as CSV and then importing. XML results in larger file sizes
which might result in making the Updater unstable.

11-01-19, 07:08 PM

Join Date:
Posts:

22-07-18
43

I tried changing in the database using the CSV file, but unfortunately the software report "is not compatiable with database editing"
which I fail to fully grasp why. Any thoughts?

#281

Youth Team Player
bendt-b 

12-01-19, 10:40 AM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

In one of the game patches, SI made some minor changes to the structure/format of the database. The Updater is designed to work
with the final structure only and will crash if you try to load a database with the older structure. I cannot remember which patch
version introduced the final structure but this is why the older version databases are incompatible with the Updater.

Edit: It's 3.6.98 and higher. It says it on the opening screen of the Updater.

I'm not sure I understand what you're getting at. If you can post a screenshot of the error then that would help.

Last edited by archibalduk; 12-01-19 at 10:53 AM.

#282

Reserve Team Player
archibalduk 

 Originally Posted by madsfrankmarkussen 

Thank you. First part - could you kindly elaborate further?

Second part: roger, checking if this work and coming back.

Sent from my iPhone using Tapatalk

 Originally Posted by madsfrankmarkussen 

I tried changing in the database using the CSV file, but unfortunately the software report "is not compatiable with database editing" which I fail
to fully grasp why. Any thoughts?

12-01-19, 03:59 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250
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Ok so I know where you're getting this error now. Dermotron coincidentally came across the same issue. It's because the csv filenames
must use the original names e.g. player_update.csv, staff_update.csv, etc.

 Originally Posted by madsfrankmarkussen 

I tried changing in the database using the CSV file, but unfortunately the software report "is not compatiable with database editing" which I fail
to fully grasp why. Any thoughts?

19-07-19, 10:01 PM

Join Date:
Location:
Posts:

28-09-17
Milton Keynes, UK

132

Ok I have read all of this thread( Thanks to Dermotron for pointing it out) and unless i'm mistaken I havent seen the answer I am
looking for. I was particularly excited to see there was a release all players as free agents option which I have done. I have loaded a
game and every player is not at a club. I chose Arsenal as they are a high reputation club with rich status and have lots of money. I
have tried to sign Aguero on an indispenable status and he obviously wants the top wage (£200k per Week) but I can only offer a max
of £20k pw despite having over £200mil in the bank. He then rejects this offer. Is there anything I have done wrong when I have
loaded this up as I assume this will be same for all top players?

#284

Hot Prospect for the Future
barfly14 

19-07-19, 10:17 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

Nothing wrong. You will need to assign a player to each club, give them a high wage and then the maximum will be fine. It's a
flaw/downside to having no players

Champman0102.co.uk Facebook Page
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#285

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

19-07-19, 10:27 PM

Join Date:
Location:
Posts:

28-09-17
Milton Keynes, UK

132

Sorry when you say assign a player to each club what do you mean? using the CM updater if so how or do you mean within the save ?

#286

Hot Prospect for the Future
barfly14 

 Originally Posted by Dermotron 

Nothing wrong. You will need to assign a player to each club, give them a high wage and then the maximum will be fine. It's a flaw/downside to
having no players

19-07-19, 10:53 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

You'll need to use cm0102ed.exe and then create a new save
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Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

20-07-19, 08:29 AM

Join Date:
Location:
Posts:

28-09-17
Milton Keynes, UK

132

Ok thanks.Do you mean for every top team ? I tend to run the top 5-6 leagues per save so wont that take a long time to do?

Sent from my SM-G955F using Tapatalk
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Hot Prospect for the Future
barfly14 
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20-07-19, 09:37 AM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

It's up to yourself but you don't do this, the wages and thus the players any club can attract, will be messed up
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Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

20-07-19, 11:16 AM

Join Date:
Location:
Posts:

28-09-17
Milton Keynes, UK

132

Ok thanks, I'll give it a go 

Sent from my SM-G955F using Tapatalk

#290

Hot Prospect for the Future
barfly14 

20-07-19, 04:22 PM

Join Date:
Location:
Posts:

28-09-17
Milton Keynes, UK

132

I've managed to do it. It took abit of time to do all 6 top leagues but it's done. Theres some proper weird transfers going on now and
I've built a nice squad for my arsenal team! Thanks for your help.

Sent from my SM-G955F using Tapatalk
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Hot Prospect for the Future
barfly14 

 Originally Posted by Dermotron 

It's up to yourself but you don't do this, the wages and thus the players any club can attract, will be messed up

20-07-19, 10:33 PM

Join Date:
Location:
Posts:

28-09-17
Milton Keynes, UK

132

One thing I have noticed on this save is while I have been signing all the free agents I want for my squad during the summer transfer
window, most of the other top sides I.e Chelsea and Man City have hardly signed anyone apart from about 4 players so once the
window had closed they had to play mostly a squad of 'greyed out' players. They have the money, the space and the wages now but
they aren't using it. In the EPL other than myself only Man Utd have signed lots of players but even then only a first 11 and hardly any
subs. Just wondering why all this is happening if anyone can provide some insight?

Sent from my SM-G955F using Tapatalk

#292

Hot Prospect for the Future
barfly14 

08-04-20, 06:28 AM

Join Date:
Posts:

01-04-20
27

I'm having the same issue as above - I can't import the database spreadsheets. Doesn't work with .csv nor .xml and it crashes while
importing. And ideas?
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Youth Team Player
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08-04-20, 10:22 AM

Join Date:
Location:
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15-12-11
Your Mother

29,995
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are you shortening the file names e.g. it exports as "exported_staff_update.csv" but you need to import as "staff_update.csv"

I am not sure this program will run against a modified exe e.g. Tapani or saturn (I'd imagine just tapani patch would be fine)
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08-04-20, 12:26 PM

Join Date:
Posts:

01-04-20
27

Yes, but an error message is coming up saying "Too many columns at row 49375 of the spreadsheet".

I've looked at that row but it doesn't seem any different to any others.

This is my first time using this tool, and am only testing it out, but I just can't seem to import at all.

Edit: Right, so I have managed to import now. Assuming I have to "save as", I did that and opened the newly saved data file in the
editor, but my changes are not there. 

An error file was created, with a few rows saying "no match". Very confusing, because I only edited one player to test it out.

Last edited by cm182; 08-04-20 at 12:36 PM.

#295

Youth Team Player
cm182 

 Originally Posted by Dermotron 

are you shortening the file names e.g. it exports as "exported_staff_update.csv" but you need to import as "staff_update.csv"

I am not sure this program will run against a modified exe e.g. Tapani or saturn (I'd imagine just tapani patch would be fine)

08-04-20, 01:55 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

Upload your csv 
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Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

08-04-20, 08:57 PM

Join Date:
Posts:

01-04-20
27

I had already deleted it. When I had tried again, it came up with a few more errors. But when I try it now, I'm getting over 30,000
errors in the errors file.

Bear in mind, from when I first posted the problem I hadn't edited anything so how could suddenly all these errors come up?

When I check the error file, it's just a huge list of players - not even ones I've edited, just seemingly random.

Something is not right with my importing process/exporting but I don't know what I'm doing wrong.

Edit: Also just to clarify, I have only attempted to update the player_update file, and the only change I have attempted in the
spreadsheet is one player name (to xyz so it's easy to find). I haven't done any mass editing or anything like that.

Ok so upon further investigation, I feel that maybe it has to do with my first_names or second_names dat files. The reason? When I go
in the editor and search for counts of "0", I get 14,522 in first names and 18,460 in second names. But if I manually check those
names, they're there, but they aren't counting in the ticker (although the names seems to work fine in-game). I never had this problem
before, usually there might have been a couple of names with a count of 0 but not that many.

It would explain why recently it takes ages to validate the database and save changes, because it seems to get stuck when aligning
names.

Last edited by cm182; 08-04-20 at 09:11 PM.
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Youth Team Player
cm182 

08-04-20, 10:12 PM

Join Date:
Location:
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15-12-11
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29,995
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Can you check if you have anyone called Ismael, Giorgos. Nationality - Afghan. Int Caps/Goals 255/255

Might be the reason for the error
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Captain

08-04-20, 11:14 PM

Join Date:
Posts:

01-04-20
27

I do not. Why that name in particular?

Something very strange has happened with my editor, seemingly specific to names which I have been experimenting a lot with recently.

I just don't understand how I can suddenly have tens of thousands of names with 0 counts - which, I presume, is causing the issue
with importing (and causing the editor to take several minutes to align names).

Last edited by cm182; 08-04-20 at 11:23 PM.
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Youth Team Player
cm182 

 Originally Posted by Dermotron 

Can you check if you have anyone called Ismael, Giorgos. Nationality - Afghan. Int Caps/Goals 255/255

Might be the reason for the error

08-04-20, 11:32 PM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

There seems to be a bug (mostly when using filters) that causes a player to be overwritten and then 'reborn' as the guy above. The
whole player index goes out of sync until he is delete, the DB is validated and then cmdbsort is run
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I've tried running cmdbsort, it found 128 errors and fixed them. 

I suppose my question now isn't why my database isn't importing... it's why are suddenly
names etc showing as 0 counts and why is the editor taking so long to align them?
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Youth Team Player
cm182 

29-04-20, 03:43 AM

Join Date:
Posts:

03-03-12
3,312

Really struggling to Import. 

*Is not compatible with database editing*
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First Team Player
Coys 

29-04-20, 09:25 AM

Join Date:
Posts:

07-03-17
828

Hi Coys. Most common reason for that is when you rename your player_update.csv to something different.
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Director
Andrea71 

 Originally Posted by Coys 

Really struggling to Import. 

*Is not compatible with database editing*
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Does anyone know how to set a player to retire as a new game is created using this tool? I tried to edit the Club Contracted to
_RETIRED but it didn't work (despite the screenshot below).

Spoiler! Show

08-05-20, 01:07 PM

Join Date:
Posts:

13-01-20
156

Nope but I am sure you can in GK Editor and/or Cm Explorer

#305

Hot Prospect for the Future
MaxiShagilko 

 Originally Posted by M.C.F.C 

Does anyone know how to set a player to retire as a new game is created using this tool? I tried to edit the Club Contracted to _RETIRED but it
didn't work (despite the screenshot below).

09-05-20, 06:09 PM

Join Date:
Posts:

31-03-19
141

Unfortunately I have 400 players I want to retire at game start... Was hoping I could do this more efficiently using this tool.

#306

Hot Prospect for the Future
M.C.F.C 

 Originally Posted by MaxiShagilko 

Nope but I am sure you can in GK Editor and/or Cm Explorer

15-05-20, 12:08 PM

Join Date:
Posts:

03-03-12
2,949

Did this get updated so it now extracts player stats also? it did pa/ca..ect but all the main ones were zeroes last time I used it. Still
want to make a 2008 0001 with that great MU team at the time as a project for future.

#307

VIP
Cam F 

15-05-20, 12:33 PM

Join Date:
Posts:

31-03-19
141

Yep you can extract everything using this - CA, PA, attributes, etc

#308

Hot Prospect for the Future
M.C.F.C 

 Originally Posted by Cam F 

Did this get updated so it now extracts player stats also? it did pa/ca..ect but all the main ones were zeroes last time I used it. Still want to
make a 2008 0001 with that great MU team at the time as a project for future.

15-05-20, 12:36 PM

Join Date:
Posts:

03-03-12
2,949

#309

VIP
Cam F 
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Cool, thanks for that,do you have the latest download of it?

15-05-20, 01:37 PM

Join Date:
Posts:

31-03-19
141

All versions available here: http://1drv.ms/1srzOKD

#310

Hot Prospect for the Future
M.C.F.C 

 Originally Posted by Cam F 

Cool, thanks for that,do you have the latest download of it?

20-06-20, 12:44 AM

Join Date:
Posts:

03-03-12
2,949

I just want to extract the DB from here https://champman0102.co.uk/downloads.php?do=file&id=49 and remove the accented symbols
not in 0001, can someone help me with that? 08 db for 0001 would be next project, the year my first son was born 

#311

VIP
Cam F 

21-06-20, 01:53 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

I haven't looked at the Updater for a very long time, but you might be able to export the club/competition/player data to a
spreadsheet and then create a new import spreadsheet with the relevant characters replaced (use Excel to do a global find and
replace). I suggest trying a sample of each table to see if it works before committing a lot of time to this, just in case it doesn't work.

#312

Reserve Team Player
archibalduk 

 Originally Posted by Cam F 

I just want to extract the DB from here https://champman0102.co.uk/downloads.php?do=file&id=49 and remove the accented symbols not in
0001, can someone help me with that? 08 db for 0001 would be next project, the year my first son was born 

The Following User Says Thank You to archibalduk For This Useful Post:

Cam F

22-06-20, 02:03 AM

Join Date:
Posts:

03-03-12
2,949

#313

VIP
Cam F 
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Thanks for the message, tried again and again but no success 

22-06-20, 08:28 AM

Join Date:
Location:
Posts:

15-12-11
Your Mother

29,995

CTRL+H in Excel or Notepad and use the Replace function perhaps? Not sure how to identify which aren't in 0001 but I'm guessing you
know those,

Champman0102.co.uk Facebook Page
13000 followers and rising

November 2020 Data Update Out Now

#314

Sir Mergements
Director
Manager
VIP
Captain

Dermotron 

22-06-20, 09:05 PM

Join Date:
Location:
Posts:

14-06-14
the English Channel

250

What exactly have you tried? Presumably you're only trying to edit a 2001/02 DB in the Updater and not a 2000/01 DB (that latter isn't
compatible with the Updater).

#315

Reserve Team Player
archibalduk 

 Originally Posted by Cam F 

Thanks for the message, tried again and again but no success 

30-06-20, 01:32 PM

Join Date:
Posts:

03-03-12
2,949

Sorry not been on recently as was off last week on holibags.

Yes, just want to edit the 0102 08 db to take out accents then save back to the 0102 db so I can extract the 0102 data for 0001 use.

#316

VIP
Cam F 

 Originally Posted by archibalduk 

What exactly have you tried? Presumably you're only trying to edit a 2001/02 DB in the Updater and not a 2000/01 DB (that latter isn't
compatible with the Updater).

30-06-20, 01:48 PM

Join Date:
Posts:

18-07-15
795

@Cam: Take out which accents - do you have a list? Or just all?

#317

Programmer
Nick+Co 

30-06-20, 02:21 PM #318
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Join Date:
Posts:

03-03-12
2,949

I figured it would take too long to work out which accents differ between the games so taking out all from 0102 was the easiest
option.

As it takes a week or more of inserting the club in but if I could do that happy in the knowledge it wouldn't crash at the end of it, it
would be worth it.

VIP
Cam F 

30-06-20, 03:38 PM

Join Date:
Posts:

18-07-15
795

@Cam: https://nic.hopto.org/open/cm0102/Fe...No-Accents.zip <--- take a look at that? Good?

#319

Programmer
Nick+Co 

30-06-20, 04:02 PM

Join Date:
Posts:

03-03-12
2,949

Looks amazing, I might pee myself 

Any chance you could do that on sep 08 https://champman0102.co.uk/downloads.php?do=file&id=49 andi will be good to go!

Thanks sooo much Nick!!!

#320

VIP
Cam F 

30-06-20, 05:05 PM

Join Date:
Posts:

18-07-15
795

https://nic.hopto.org/open/cm0102/Se...No-Accents.zip 

#321

Programmer
Nick+Co 

The Following User Says Thank You to Nick+Co For This Useful Post:

Cam F

30-06-20, 06:00 PM

Join Date:
Posts:

03-03-12
2,949

#322

VIP
Cam F 
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Aaaw Nick  

You have made another one of my dream dbs possible, thank you so much!!!

2008 for 0001 it will be. Year of my first son Josh's birth, another db for a year that meant something to me.
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